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	� 12-M« tF¥ã‰fhd RuhÉ‹ fÂÅ ga‹ghLfŸ 

tÊfh£oia btËÆLtâš bgUÄjK« k»œ¢áí« 

mil»nwh«. fÂÅ ga‹ghLfŸ ghl§fS¡fhd Édh 

ÉilfŸ Äfî« vËikahf, Rygkhf òÇªJbfhŸS« 

Éj¤âš ekJ tÊfh£oÆš ju¥g£LŸsd.

RuhÉ‹ fÂÅ ga‹ghLfŸ tÊfh£o khzt/

khzÉfË‹ všyh¤ njitfisí« fU¤âš 

bfh©L cUth¡f¥g£LŸsJ. ghlüiy e‹F 

kâ¥ghŒî brŒJ khzt / khzÉfŸ  všyh¥ 

ghl§fisí« btFthf c£»u»¤J m¿ªJbfh©L 

nj®it Rygkhf vGâ mâf kâ¥bg©fis¥ bg‰W 

bt‰¿ahs®fshF« Éj¤âš, ekJ bt‰¿¡fhd ïªj 

tÊfh£o jahÇ¡f¥g£LŸsJ.

MáÇa®fS¡F ghl« el¤JtâY«, khzt/

khzÉfS¡F¡ f‰W¡bfhŸtâY« ïªj tÊfh£o 

Jizahf ïU¡F«.

ekJ RuhÉ‹ fÂÅ ga‹ghLfŸ tÊfh£oÆš ïJ 

ngh‹w gy áw¥g«r§fŸ ml§»ÆUªjhY«, khzt/

khzÉfŸ òÇªJbfhŸs cjÉL« MáÇa®fË‹ 

gÂí« kf¤jhdJ v‹gij kW¥gj‰»šiy.

MáÇa®fË‹ f‰W¤jU« gÂÆš cWJizahfî«, 

khzt/khzÉfŸ ghl§fis¡ f‰F« Éj¤âš C¡f« 

jU« tifÆY« ekJ tÊfh£o âfG« vd e«ò»nwh«.

ïiwaUis nt©L»nwh«.

eynk Éisf!

RghZ uh{, B.E., M.S.
� - gâ¥gf¤jh®

thœ¤J¡fŸ !!!

gâ¥gháÇa® ciu

(ii)
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bghUsl¡f«

(iv)

ghl« 
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1
ghl« gšÿlf« k‰W« fÂ¥bgh¿¥ 

gâ¥gf«

gFâ - m

I. rÇahd Éilia¤ nj®ªbjL¤J vGJf.

1.	 __________ v‹gJ x‹¿‰F nk‰g£l Clf 
tifahd ciu, jiufiy, xË¡fh£á, mirñ£lš 
k‰W« xÈ M»at‰¿š VnjD« xU tif¥ 
ga‹gh£il¡ F¿¡F«.

m)	 Ãiwnt‰w¥gL« nfh¥ò� [Govt.MQP-2019]
M)	 fÂÅ gâ¥gf«

ï)	 gšÿlf«		   <)	 Ûîiu

� [Éil: ï) gšÿlf«]
2.	 gšÿlf¤â‹ FiwghLfËš x‹W mjDila 

___________.
m)	 Éiy	 		  M)	 x¤J¥nghjš

ï)	 ga‹ghL		  <)	 rh®ãašò

� [Éil: m) Éiy]
3.	 ÉÇth¡f« JPEG

m)	 Joint Photo exports gross
M)	 Joint Photographic experts group
ï)	 Joint processor experts group
<)	 Joint Photographic expression group
� [Éil: M) Joint Photographic Experts 

Group]
4.	 gšÿlf¤ij cUth¡f ek¡F njitahdit: 

t‹bghUŸ, bk‹bghUŸ k‰W« ____________.
m)	 tiyaik¥ò	 M)	 CD ïa¡»

ï)	 ešy nahrid	 <)	 Ãuyh¡f âw‹

� [Éil: ï) ešy nahrid]
5.	 rÇahd x‹iw¤ nj®ªbjL¤J ã‹tUtdt‰iw 

bghU¤Jf.

1. ciu	 – 	 TGA
2. ÃH‰gl«	 – 	 MIDI
3. xÈ	 – 	 MPEG
4. xË	 – 	 RTF

m)	 1, 2, 3, 4	 	 M)	 2, 3, 4, 1
ï)	 4, 1, 2, 3		  <)	 3, 4, 1, 2�

� [Éil: ï) 4,1,2,3]
6.	 ã‹tUtdt‰¿š bghUªjhj x‹iw¡ 

f©Lão¡fî«.

m)	 TIFF			   M)	 BMP
ï)	 RTF			   <)	 JPEG�

� [Éil: ï) RTF]
7.	 __________ v‹gJ mirah ÃH‰gl§fis 

bjhl®¢áahd ïa¡fkhf fh£á¥gL¤J« braš.

m)	 ciu tot«		

M)	 xÈ

ï)	 MP3			 

<)	 mirñ£lš

� [Éil: <) mirñ£lš]
8.	 ïiza¤â‹ _y« Ãfœneu Ãfœ¢áfis 

neuoahf xË¥gu¥òtij _________ 
v‹»nwh«.� [HY-2019]
m)	 tiy xË¥gu¥ò	

M)	tiy bjhF¥ghs®

ï)	 juî ifahSjš

<)	 ït‰¿š VJ« ïšiy

� [Éil: m) tiy xË¥gu¥ò]
9.	 GIF ga‹gL¤J« t©z njlš m£ltiz 

__________.
m)	 8 ã£ 			   M)	 13 ã£ 

ï)	 8 MB			   <)	 13 MB
� [Éil: M) 13 ã£]

10.	 RTF nfh¥ò tot¤ij m¿Kf¥gL¤âaJ 
_________.
m)	 TCS			   M)	 Microsoft
ï)	 Apple			   <)	 IBM�

� [Éil: M) Microsoft]

Édh¡fŸ
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gFâ - M

II. _‹W tÇfËš ÉilaË¡fî«.

1.	 tiuaW - gšÿlf« k‰W« mj‹ áw¥g«r«.�
� [Sep-2020]

Éil.	gšÿlf« v‹D« brhš ‘gy' k‰W« ‘Clf«' 

vd ïu©L brh‰fis cŸsl¡»aJ. mjhtJ 

Clf§fË‹ gy tot§fis x‹whf ïiz¡»wJ. 

nrÄ¤jš, jftš bjhl®ò, tH§fš k‰W« 

ciu, xË, ÃH‰gl«, tiufiy k‰W« xÈ 

M»at‰¿‹ cŸçL/btËpL ClhLjš 

ngh‹w nritfisí« tH§F»wJ.

mj‹ áw¥g«r« :

(i)	 Clf§fis xnu Clf¤âš xnu jftš 

bjhF¥ãš x‹¿iz¡»wJ.

(ii)	 jftšJiwÆš gšÿlf« rÛg¤âa 

br¿ñ£L« mDgtkhf kh¿ tU»wJ. 

2.	 gšÿlf TWfis¥ g£oaÈLf.

Éil.	gšÿlf« ciu, ÃH‰gl«, xÈ, xË k‰W« 

mirñ£lš M»a IªJ K¡»a¡ TWfis¡ 

bfh©LŸsJ. 

3.	 gšÿlf¤âš ciu (Text) T¿id tif¥gL¤Jf.

Éil.	(i)	 Ãiyahd ciu (Static text)
(ii)	 Û ciu (Hyper text)

4.	 gšÿlf¤âš ÃH‰gl T¿id tif¥gL¤Jf.

Éil.	(i)	 ã£nk¥ mšyJ br›tf gl§fŸ

(ii)	 bt¡l® gl§fŸ

5.	 tiuaW - mirñ£lš k‰W« mj‹ áw¥g«r«.�

Éil.	mirah gl§fis Äf Éiuthf¡ fh©ã¥gj‹ 

_y« mt‰iw bjhl®¢áahd mirî ngh‹w 

cz®it bfhL¡F« brany mirñ£lš 

MF«.

mj‹ áw¥g«r« : 

(i)	 mirñ£lš ïU mšyJ K¥gÇkhz§fis¡ 

bfh©lJ.

(ii)	 mirñ£lš fUÉfŸ Äfî« r¡â thŒªjit 

k‰W« âwik thŒªjit MF«.

6.	 ÃH‰gl nfh¥ò tot§fis¥ g£oaÈLf.

Éil.	(i)	 TIFF (Tagged Image File Format)
(ii)	 BMP (BitMap)
(iii)	 DIP (Device Independent BitMap)
(iv)	 GIF (Graphics Interchange Format)
(v)	 JPEG (Joint Photographic Experts Group)
(vi)	 TGA (Tagra)
(vii)	 PNG (Portable Network Graphics)

7.	 xÈ nfh¥ò tot§fis¥ g£oaÈLf.�
� [Govt.MQP-2019]

Éil.	(i)	 WAV (Waveform AudioFile Format)
(ii)	 MP3 (MpEG layer - 3 Format)
(iii)	 OGG�
(iv)	 AIFF (Audio Interchange File Format)
(v)	 WMA (Windows Media Audio)
(vi)	 RA (Real Audio Format)

8.	 xË¡fh£á nfh¥ò tot§fis¥ g£oaÈLf.

Éil.	(i)	 AVI (Audio / Video Interleave)
(ii)	 MPEG (Moving Picture Experts Group)

9.	 tiuaW - gšÿlf cUth¡f«.

Éil.	gšÿlf¤ij cUth¡Ftj‰F nghJkhd 

neu« k‰W« âwikahd â£lÄlš M»ait 

njit¥gL»‹wd. ïJ â£l¥gÂ R_fkhf 

bjhluî« k‰W« jftš ïy¡F gh®itahs®fis¢ 

br‹wilaî« cWâ brŒ»wJ.

10.	 gšÿlf cUth¡f FG cW¥ãd®fis g£oaÈLf.

Éil.	(i)	 jahÇ¥ò nkyhs®

(ii)	 bghUsl¡f tšYe®

(iii)	 °»Ç¥£ vG¤jhs®

(iv)	 ciu gâ¥ghs®

(v)	 gšÿlf totik¥ghs®

(vi)	 fÂÅ tiufiy fiyP®

(vii)	 xÈ k‰W« xË¡fh£á tšYe®

(viii)	fÂÅ Ãuy®

(ix)	 tiy tšYe®

gFâ - ï

III. xU g¤âasÉš ÉilaË¡fî«.

1.	 gšÿlf TWfis RU¡fkhf ÉtÇ.

Éil.	gšÿlf¤â‹ TWfŸ :

(i)	 ciu : gšÿlf¤â‹ mo¥gil TW 

ciu MF«. k‰w ãw eg®fSl‹ jftš 

bjhl®ã‰fhd Äfî« bghJthd tÊ ïJ 

MF«.

(ii)	 gl« : gšÿlf¤âš gl§fŸ K¡»a¡ 

Twhf brašgL»‹wd. fÂÅÆš ïªj 

gl§fis ã£nk¥ mšyJ br›tf gl« 

k‰W« bt¡l® gl§fŸ vd ïUtifÆš 

cUth¡fyh«.
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(iii)	 mirñ£lš : mirah gl§fis Äf 

Éiuthf fh©ã¥gj‹ _y« mt‰iw 

bjhl®¢áahd mirî ngh‹w cz®it 

bfhL¡F« brany mirñ£lš MF«.

(iv)	 xÈ : xÈ v‹gJ vªjbthU bkhÊÆY« cŸs 

m®¤jKŸs ng¢rhF«. gšÿlf¤âYŸs 

xU K¡»a Twhd ïJ, ïirÆ‹ ï‹g«, 

áw¥ò jh¡f§fŸ ngh‹wt‰iw tH§F»wJ.

(v)	 xË¡fh£á : gâî brŒa¥g£l Ãfœî, fh£á 

ngh‹wt‰iw¡ fh©ã¤jiy xË¡fh£á 

v‹»nwh«.

2.	 mirñ£lÈ‹ áw¥g«r§fŸ k‰W« bjhÊš 
E£g§fis ÉtÇ¡fî«.

Éil.	áw¥g«r§fŸ :

(i)	 mirñ£lÈš, âiu bghUŸ v‹gJ xU 

bt¡l® glkhF«.

(ii)	 v©kh‰w¤ij¥ ga‹gL¤â 

xU§»iz¥òfis tiuaW¡f gl¤Jl‹ 

mj‹ ghijÆ‹ ïa¡f« fz¡»l¥gL«.

(iv)	 mirñ£lš ïU mšyJ K¥gÇkhz§fis¡ 

bfh©lJ.

(v)	 mirñ£lš fUÉfŸ Äfî« r¡â thŒªjit 

k‰W« âwik thŒªjit MF«.

ghij mirñ£lš : khwhj ã‹dÂia¡ 

bfh©l âiuÆš xU bghUis ef®¤Jtij 

cŸsl¡»aJ ghij mirñ£lš MF«.

r£lf mirñ£lš : ïªj mirñ£lÈš, 

gy bghU£fŸ xnu rka¤âš ef®tj‰F 

mDkâ¡»wJ k‰W« ã‹dÂ mšyJ 

bghUŸfS« khW»wJ. 

3.	 cUth¡f FG cW¥ãd®fË‹ gÂfŸ k‰W« 
bghW¥òfis¥ g‰¿ vGJf.

Éil.	(i)	� jahÇ¥ò nkyhs® : gšÿlf cUth¡FjÈš, 

F¿¤j neu¤âš KG ju¤Jl‹ gšÿlf 

â£l cUth¡f¤ij tiuaW¥gJ k‰W« 

xU§»iz¥gJ jahÇ¥ò nkyhsÇ‹ g§F 

MF«.

(ii)	 bghUsl¡f tšYe® : bghUsl¡f 

tšYe® v‹gt® V‰fdnt â£lÄl¥g£l 

ga‹gh£o‹ bghUsf¤ij¥ g‰¿a 

mid¤J MuhŒ¢á brašghLfisí« 

brŒtj‰F bghW¥ghdt® Mth®.

(iii)	 °»Ç¥ vG¤jhs® : fU¤JU¡fis 

K¥gÇkhz NHšfËš fh£á¥gL¤J»wh®. 

njit V‰go‹ Ãuš ÛJ bkŒÃf® c©ik 

xU§»iz¥ig¥ ga‹gL¤jyh«.

(iv)	 ciu¥ gâ¥ghs® : ciu v¥bghGJ« 

f£lik¥ghfî« rÇahd ïy¡fz¤njhL« 

ïU¡f nt©L« v‹gj‰F bghW¥ghdt®.

bghW¥òfŸ :

(i)	 gšÿlf cUth¡f¤âš mâfg£r gyid 

ca®ju âwikíl‹ bgW« tifÆš FG 

cW¥ãd®fis nkyh©ik brŒtJ 

f£lhakhF«.

(ii)	 ï¡FG t‹bghUŸ k‰W« bk‹ bghUŸfË‹ 

tu«òfis m¿ªJ brašgl nt©L«.

4.	 gšÿlf¤âš cŸs gšntW nfh¥ò tot§fŸ g‰¿ 
ÉtÇ¡fî«. � [HY-2019; March-2020]

Éil.	ciu tot§fŸ :

(i)	� RTF : Kj‹ik nfh¥ò tot« RTF (Rich 
Text Format) ik¡nuhrh¥£ ÃWtd¤jhš 

1987 M« M©L m¿Kf¥gL¤j¥g£lJ.

(ii)	� Plain Text : gy tiu gâ¥gh‹fËš âw¡f, 

go¡f k‰W« gâ¥ghŒî brŒa ïit 

ga‹gL»wJ.

ÃH‰gl tot§fŸ :

(i)	 GIF (Graphics Interchange Format): GIF 
v‹gJ FW¡f¥g£l ÃH‰gl totkhF«. 

bgU«ghyhd fÂÅ t©z ÃH‰gl§fŸ 

k‰W« ã‹dÂfŸ GIF nfh¥òfshF«.

(ii)	 JPEG (Joint Photographic Experts Group): JPEG 
mâfg£r ÃH‰gl FW¡f¤ij miltj‰fhf 

totik¡f¥g£LŸsJ. ïJ ïH¥òila 

FW¡f E£g¤ij¥ ga‹gL¤J»wJ. 

xÈnfh¥ò tot§fŸ :

(i)	 WAV (Waveform Audio File Format): ïJ 

É©nlhÌš FW¡f¥glhj xÈ nfh¥òfis¢ 

nrÄ¡F« Äfî« ãugykhd xÈ nfh¥ò 

totkhF«.

(ii)	 MP3 (MPEG - 3 Format) : ïiria nrÄ¡fî« 

gâÉw¡f« brŒaî« Äfî« ãugykhd 

tot« MPEG Layer - 3 totkhF«.

xË¡fh£á nfh¥ò tot§fŸ :

(i)	 AVI (Audio / Video Interleave) : ïJ 

É©nlhÌ‰fhd xU xË¡fh£á nfh¥ò 

totkhF«. 

(ii)	 MPEG (Moving Pictures Experts & Group) : 
ïJ xÈ k‰W« xË bghUsl¡f¤ij¤ 

njLtj‰fhd ju ÃiyahF«. 
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IV. xU g¡f msÉš ÉilaË¡fî«.

1.	 gšÿlf brašfŸ g‰¿ ÉÇthf És¡fî«. 

� [QY-2019; Sep-2020]

Éil.	(i)	 �fU¤JU gF¥ghŒî k‰W« â£lÄlš: 

gšÿlf¤ij cUth¡F« brayhdJ 

fU¤JUit bjhl¡f¥òŸËahf bfh©L 

bjhl§F»wJ. fU¤JU gF¥ghŒî 

bghU¤jkhd fU¥bghUŸ, tuî-bryî 

â£l« k‰w« nj®î brŒj fU¥bghUË‹ 

bghUsl¡f¤â‹ ïU¥ò M»at‰iw 

milahs« fh©»‹wJ. TLjyhf, 

gâ¥òÇik ãu¢ridfisí« ïªj 

goÃiyÆš fU¤âš bfhŸs¥gL»wJ.

(ii)	 â£l totik¥ò : xUKiw fU¥bghUis 

ïWâ brŒjãwF, gšÿlf¤â‹ 

â£l¤â‰fhd neh¡f§fŸ, F¿¡nfhŸfŸ 

k‰W« brašghLfŸ M»ait 

totik¡f¥gL»‹wd.

(iii)	 K‹ - cUth¡Fjš : â£lÄlš k‰W« 

totik¤jÈ‹ mo¥gilÆš â£l¤ij 

cUth¡FtJ njitahdJ MF«.

(iv)	 tuî-bryî â£lÄlš : Mnyhrf®fŸ, 

t‹bghUŸ, bk‹bghUŸ, gaz«, 

jftš bjhl®ò k‰W« ãuRÇ¤jš ngh‹w 

x›bthU ÃiyÆY« mid¤J gšÿlf 

â£l§fS¡F« tuî-bryî â£l« 

njhuhakhf¡ fz¡»l¥gL»wJ.

(v)	 gšÿlf¤ij cUth¡F« FG: ca®ªj 

gšÿlf â£l¤ij cUth¡F« FGÉ‰F 

mªj FGÉ‹ x£l bkh¤j Ka‰á njit. 

ïªj FGthdJ °»Ç¥£ vG¤jhs®, 

jahÇ¥ò nkyhs®, gâ¥gháÇa®, tiufiy 

totik¥ghs®, gšÿlf totik¥ghs® 

k‰w« tiy tšYe® ngh‹w gšntW 

gjÉfisí« k‰W« bghW¥òfisí« 

brŒí« cW¥ãd®fis bfh©lJ.

(vi)	 t‹bghUŸ / bk‹bghUŸ nj®ªbjL¤jš: 

t‹ bghUshdJ nj®ªbjL¤j ntfkhd 

ika¢brayf«, RAM k‰W« bgÇa âiuaf«, 

gâîfis¢ nrÄ¡f njitahd t£LfŸ 

M»at‰iw cŸsl¡»aJ. bghU¤jkhd 

bk‹bghUŸ k‰W« nfh¥ò tot§fis¤ 

nj®ªbjL¤jš v‹gJ cUth¡f¥gL« â£l¥ 

gÂ¡F »il¡F« Ãâia¥ bghW¤jjhF«.

(vii)	 f£lik¥ig jah® brŒjš : ÉÇthd 

f£lik¥ãš mid¤J goÃiyfS« 

mL¤jL¤J tU« brašgh£o‰fhd neu 

msî g‰¿a jftšfis¡ f©o¥ghf 

bfh©oU¡f nt©L«.

2.	 mirñ£lš E£g§fŸ g‰¿ ÉÇthf És¡fî«.
Éil.	mirñ£lš :

(i)	 mirah gl§fis (Still images) Äf 

Éiuthf fh©ã¥gj‹ _y« mt‰iw 

bjhl®¢áahd mirî ngh‹w cz®it 

bfhL¡F« brany mirñ£lš MF«.

(ii)	 mirñ£lÈš, âiu bghUŸ v‹gJ 

xU bt¡l® glkhF«. v© kh‰w¤ij¥ 

ga‹gL¤â xU§»iz¥òfis (Coordinates) 
tiuaW¡f gl¤Jl‹ mj‹ ghijÆ‹ 

ïa¡f« fz¡»l¥gL«.

(iii)	 Fiwªjg£r r£lf É»j« (Framerate) 
16 r£l§fŸ Éeho vd ïUªjhš 

bk‹ikahd njh‰w¤ij¡ bfhL¡F«.

ïa‰if njh‰w¤â‰F Fiwªjg£r« 

Éeho¡F 25 r£lf§fshf ïU¤jš 

nt©L«. mirñ£lš ïU mšyJ 

K¥gÇkhz§fis¡ bfh©lJ.  

(iv)	 âiuÆš X k‰W« Y m¢RfS¡»ilnaahd 

gu¥ãš ïU gÇkhz mirñ£lš ÃH‰gl¤ij 

cÆnuh£lkhf bfh©L tU»wJ.

(v)	 K¥gÇkhz mirñ£l¤âš X, Y k‰W« Z 

M»a _‹W m¢RfS¡»ilna cÆnuh£l« 

eilbgW»wJ. mirñ£lš fUÉfŸ 

Äfî« r¡âthŒªjit k‰W« âwik 

thŒªjit MF«. ïu©L tifahd 

mirñ£lšfshtd:

	 ghij mirñ£lš (path animation) k‰W« 

r£lf« mirñ£lš (Frame animation).
ghij mir ñ£lš :

(i)	 khwhj ã‹dÂia¡ bfh©l âiuÆš 

xU bghUis ef®¤Jtij cŸsl¡»aJ 

ghij mirñ£lš MF«.

(ii)	 v.fh. ã‹dÂ mšyJ fjhgh¤âu¤âš 

VnjD« kh‰w§fis brŒjhY« j‹id 

bghU£gL¤jhkš nfÈ¢á¤âu fjhgh¤âu« 

âiu KGtJ« ef®¤j¥gL«.

	 r£lf mirñ£lš : 

ïªj mirñ£lÈš, gy bghU£fŸ xnu 

rka¤âš ef®tj‰F mDkâ¡»wJ k‰W« 

ã‹dÂ mšyJ bghUŸfS« khW»wJ.
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3.	 mirñ£lš âiu¥gl JiwÆš cŸs thŒ¥òfŸ 
g‰¿ f©l¿aî«.� [QY-2019]

Éil.	(i)	 âiu¥gl§fŸ, bjhiy¡fh£á Ãfœ¢áfŸ 

M»at‰¿š mirñ£lÈ‹ g§F 

ï‹¿aikahjjhF«. 

(ii)	 j‰nghija ÃiyÆš, Vw¡Fiwa x›bthU 

Ûoah ÃWtdK« mÅnkõÅ‹ VnjD« 

xU tot¤ij¥ ga‹gL¤â tU»‹wd. 

(iii)	 ÛoahÉ‹ Mjhu m«rkhf mirñ£lš 

Jiw kh¿ tU»wJ.

(iv)	 mirñ£lš Jiwia¥ bghU¤jtiu, 

j‰nghJ ïªâah 30 rjåj ntf¤âš 

ts®¢áailªJ tU»wJ. 

(v)	 v¢.ã.X bjhiy¡fh£á¤ bjhl®, kh®btÈ‹ 

mnt‹#®° âiu¥gl bjhl® ngh‹w 

r®tnjr âiu¥gl§fS¡F “mirñ£lš” 

g§F ï‹¿aikahjJ.

(vi)	 mirñ£lš JiwÆ‹ njit 

âiu¥gl¤JiwÆš ehS¡F ehŸ 

mâfÇ¥gj‹ _y« gy khzt®fŸ go¥ãš 

mâf M®t« bfh©L nrU»‹wd®.

4.	 gšÿlf cUth¡f FGÉ‹ gÂfŸ k‰W« 
bghW¥òfŸ ÉÇthf vGjî«.� [HY-2019]

Éil.	(i)	� jahÇ¥ò nkyhs® : gšÿlf cUth¡FjÈš, 

F¿¤j neu¤âš KG ju¤Jl‹ gšÿlf 

â£l cUth¡f¤ij tiuaW¥gJ k‰W« 

xU§»iz¥gJ jahÇ¥ò nkyhsÇ‹ 

g§F MF«. jahÇ¥ò nkyhs® v‹gt® 

bjhÊšE£g âw‹fŸ, e‹F â£l« tiujš, 

fyªJiuahlš âw‹fŸ k‰W« tuî - 

bryî nkyh©ik âw‹fŸ M»at‰¿š 

Ãòz¤Jt« bg‰wtuhf  ïU¤jš nt©L«.

(ii)	 bghUsl¡f tšYe® : bghUsl¡f 

tšYe® v‹gt® V‰fdnt â£lÄl¥g£l 

ga‹gh£o‹ bghUsf¤ij¥ g‰¿a 

mid¤J MuhŒ¢á brašghLfisí« 

brŒtj‰F bghW¥ghdt® Mth®. 

(iii)	 °»Ç¥£ vG¤jhs® : °»Ç¥£ vG¤jhs® 

fU¤JU¡fis K¥gÇkhz NHšfËš 

fh£á¥gL¤J»wh®. njit V‰go‹, Ãuš 

ÛJ bkŒÃf® c©ik xU§»iz¥ig¥ 

ga‹gL¤jyh«.

(iv)	 ciu gâ¥ghs® (Text Editor): gšÿlf 

cUth¡FjÈ‹ bghUsl¡f« v¥bghGJ« 

jU¡fßâahd X£lkhf ïU¤jš nt©L«. 

ciu v¥bghGJ« f£lik¥ghfî« rÇahd 

ïy¡fz¤njhL« ïU¡f nt©L«. 

ciu k‰W« ÉtÇ¤jš ga‹gh£o‹ 

xU§»izªj gFâahF«.

(v)	 gšÿlf totik¥ghs® : gšÿlf 

totik¥ghs® gšÿlf¤â‹ mid¤J 

mo¥gil¤ bjhFâfshd tiufiy, ciu, 

xÈ, ïir, xË¡fh£á, òif¥gl« k‰W« 

gil¥gh¡f bk‹bghUis¥ ga‹gL¤â 

mirñ£lš ngh‹wt‰iw xU§»iz¥gh®. 

(vi)	 fÂÅ tiufiyfiyP® : ÃuÈ‹ 

tiufiy TWfshd ã‹dÂ, òšy£fŸ, 

bgh¤jh‹fŸ, ghl¥gâ¥ghŒî, 3-D 

bghUŸfŸ, mirñ£lš k‰W« á‹d§fŸ 

M»at‰iw¡ ifahS« g§»id fÂÅ 

tiufiy fiyP® t»¡»wh®. 

(vii)	 xÈ k‰W« xË¡fh£á tšYe® : 
vL¤Jiu¤jš k‰W« nrÄ¡f¥g£l 

xË¡fh£áfis¥ gšÿlf Ãfœ¤JjÈš 

ifahs¤ njit¥gLgtnu xÈ k‰W« 

xË¡fh£á tšYe® Mth®. gâî brŒjš, 

xÈ Éisîfis gâ¥ghŒî brŒjš 

k‰W« ïy¡fkh¡fš M»at‰W¡F 

ïtnu bghW¥ghdt® Mt®.

5.	 gšÿlf nfh¥ãš cŸs bt›ntW nfh¥ò tot§fis 
ÉtÇ¡fî«.� [March-2020]

Éil.	gšÿlf juîfis cUth¡», mjid 

tH§Ftj‰F ga‹gL¤j¥gL« el¥ò nfh¥ò 

tot§fË‹ És¡f« ã‹tUkhW : 

ciu tot§fŸ : 

(i)	 RTF Kj‹ik nfh¥ò tot« RTF (Rich Text 
Format) ik¡nuhrh¥£ ÃWtd¤jhš 1987 M« 

M©L ãuRÇ¡f¥g£l jahÇ¥òfË‹ F¿¥òfŸ 

k‰W« FW¡F gÂ¤js Mtz§fË‹ 

gÇkh‰w§fnshL m¿Kf¥gL¤j¥g£lJ. 

(ii)	 Plain Text nfh¥òfis gy ciu gâ¥gh‹fËš 

âw¡fyh«, go¡fyh« k‰W« gâ¥ghŒî 

brŒayh«. Note pad (Windows), Gedit 
mšyJ nanp (UNIX, Linux) Text edit (Mac 
Os) ngh‹witýbghJthf ga‹gL»wJ.

	 ÃH‰gl tot§fŸ : 
(i)	 TIFF (Tagged Image File format): ïªj 

tot« fÂ¥bgh¿ gâ¥gf cy»š (mâf 

jukhd btËpL) bghJthdJ MF«. 

ïJ bgU«ghY« mid¤J bk‹bghUŸ 

bjhF¥òfis MjÇ¡»wJ.

(ii)	 BMP (Bitmap) : bjhl¡f¤âš ïªj totkhdJ 

É©nlh° 3.1-š ga‹gL¤j¥g£lJ. ïJ 

Äfî« bgÇaJ k‰W« FW¡fk‰wJ.

(iii)	 DIB (Device Independent Bitmap) : ïªj tot« 

BMP-ia x¤jjhF«. ïJ nfh¥òfis gšntW 

rhjd§fËš fh©ã¡f mDkâ¡»wJ.
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(iv)	 GIF (Graphics Interchange Format): GIF 

v‹gJ FW¡f¥g£l ÃH‰gl totkhF«. 

bgU«ghyhd fÅÂ  t©z ÃH‰gl§fŸ 

k‰W« ã‹dÂfŸ GIF nfh¥òfshF«. 

Fiwªj msî t©z§fis¥ ga‹gL¤J« 

tiufiy¡F ïªj nfh¥ò tot« Äf¢áwªj 

bghU¤jkhF«.

(v)	 JPEG (Joint Photographic Experts Group): JPEG 

mâfg£r ÃH‰gl FW¡f¤ij miltj‰fhf 

totik¡f¥g£LŸsJ. ïJ ïH¥òila 

FW¡f E£g¤ij¥ ga‹gL¤J»wJ. 

ÃH‰gl¤ij Û©L« f£lik¡f¤ njit¥gL« 

juîfËš áyt‰iw ïH¥gnj , ïH¥òila 

FW¡fkhF«.

(vi)	 TGA (Tagra) : ïJ mâf bjËî¤âw‹ 

ÃH‰gl§fS¡fhd Kjš ãugykhd 

totkhF«.

(vii)	 PNG (Portable Network Graphics) : ïJ Fiwªj 

ïH¥ò, á¿aJ k‰W« e‹F FW¡f¥g£L 

br›tf ÃH‰gl§fshf nrÄ¡f¥gL« xU 

Ú£o¥ò nfh¥ò totkhF«. ïJ GIF-¡F 

kh‰whf brašgL»wJ.

	 ïy¡f xÈ nfh¥ò tot§fŸ: 
(i)	 WAV (Waveform Audio File Format): ïJ 

É©nlhÌš FW¡f¥glhj xÈ nfh¥òfis¢ 

nrÄ¡F« Äfî« ãugykhd xÈ nfh¥ò 

totkhF«. Fiw¡f¥g£l nfh¥ã‹ msit¥ 

bgWtj‰fhf MP3 ngh‹w k‰w nfh¥ò 

tot§fS¡F kh‰¿ mik¡f Koí«.

(ii)	 MP3 (MPEG layer - 3 Format) ïiria 

nrÄ¡fî« gâÉw¡f« brŒaî« Äfî« 

ãugykhd tot« MPEG Layer-3 totkhF«.

(iii)	 OGG : áwªj X£l¤âid miltj‰fhf 

totik¡f¥g£l ïytr âwªj _y 

bfhŸfy‹ (Container) totkhF«.

muR bghJ¤ nj®î khâÇ Édh ÉilfŸ

1 kâ¥bg©

1.	 khwhj ã‹dÂia¡ bfh©l âiuÆš xU 

bghUis ef®¤Jtij cŸsl¡»aJ. [QY-2019]
m)	 ghij mirñ£lš

M)	 r£lf« mirñ£lš

ï)	 ïu©L«

<)	 ït‰¿š vJî« ïšiy

� [Éil: m) ghij mirñ£lš]

2.	 Ñœf©lt‰¿š vJ/vit jtwhd ïiz.�
� [QY-2019]
1)	 DIB	 -	 �nfh¥òfis gšntW rhjd§fËš 

fh£l

2)	 Ra	 -	 �ïiza¤âš xÈÆ‹ x£l¤â‰fhf 

totik¡f¥g£ljhF«

3)	 RTF	 -	 �M¥ãŸ ÃWtd¤jhš 

m¿Kf¥gL¤j¥g£lJ

4)	 TGA	 -	 �bgU«ghyhd xË¡fh£á ão¥ò 

gyiffŸ ïij MjÇ¡»‹wd.

m)	 1 k‰W« 2	 M)	 2 k‰W« 3

ï)	 3 k£L«	 <)	 4 k£L«

� [Éil: ï) 3 k£L«]
3.	 MIDI- ‹ ÉÇth¡f« v‹d?� [March-2020]

m)	 Musical Information Digital Intrepreter
M)	 Musical Instrument Digital Information
ï)	 Musical Intelligent Digital Interface
<)	 Musical Instrument Digital Identifier�
� [Éil: <) Musical Instrument Digital 
� Identifier]

4.	 gšÿlf mirñ£lÈš Fiwªjg£r r£lf 
É»j« (Frame rate) :� [Sep-2020]
m)	 10	 M)	 12	

ï)	 15	 <)	 16�

� [Éil: <) 16]
5.	 vJ gšÿlf ÃH‰gl tot« mšy?� [Sep-2020]

m)	 AIFF	 M)	 GIF	
ï)	 TIFF	 <)	 JPEG�
� [Éil: m) AIFF]

2 kâ¥bg©fŸ

1.	 fÂÅ ÃuyÇ‹ gÂfŸ k‰W« bghW¥òfis 
vGJ.� [QY-2019]

Éil.	(i)	 �fÂÅ Ãuy® bghU¤jkhd bkhÊÆš 

F¿Kiw mšyJ °»Ç¥£ tÇfis 

vGJ»wh®.

 (ii)	  �ïªj °»Ç¥£fŸ tH¡fkhf áw¥ò brašghLfis 

cUth¡F«. mjhtJ xË¡fh£á âiuÆ‹ 

msî k‰W« tot¤ij¡ bfhL¥gj‰fhd 

bk‹bghUis cUth¡Fjš, òw¡fUÉfis¡ 

f£L¥gL¤Jjš ngh‹wit MF«.

2.	 mirñ£lš v‹whš v‹d? mj‹ tiffŸ ahit?
� [March-2020]

Éil.	mirah gl§fis Äf Éiuthf¡ fh©ã¥gj‹ 

_y« mt‰iw bjhl®¢áahd mirî ngh‹w 

cz®it bfhL¡F« brany mirñ£lš 

MF«. 

tiffŸ : 1. ghij mirñ£lš 2. r£lf 

mirñ£lš 
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1.	 ghij mirñ£lš : khwhj ã‹dÂia¡ 

bfh©l âiuÆš xU bghUis ef®¤Jtij 

cŸsl¡»aJ ghij mirñ£lš MF«.

2.	 r£lf mirñ£lš : ïªj mirñ£lÈš, 

gy bghU£fŸ xnu rka¤âš ef®tj‰F 

mDkâ¡»wJ k‰W« ã‹dÂ mšyJ 

bghUŸfS« khW»wJ. 

TLjš Édh¡fŸ

rÇahd Éilia¤ nj®ªbjL¤J vGJf. (1 kâ¥bg©)

1.	 jftš JiwÆš rÛg¤âa br¿ñ£L« 
mDgtkhf kh¿ tUtJ 

m)	 mUtkh¡f«	 M)	 gšÿlf«

ï)	 g‰gy brayh¡f«

<)	 ït‰¿š vJîÄšiy

� [Éil: M) gšÿlf«]
2.	 gšÿlf« v‹D« brhš v¤jid brh‰fis 

cŸsl¡»aJ?

m)	 ïu©L	 M)	 _‹W

ï)	 eh‹F	 <)	 IªJ

� [Éil: m) ïu©L]
3.	 gšÿlf¤â‹ mo¥gil TW

m)	 Ûciu	 M)	 mirñ£lš

ï)	 xË	 <)	 ciu

� [Éil: <) ciu]

4.	 ÃH‰gl«, xÈ, xË k‰W« tiufiy 
M»at‰iw cŸsl¡»aJ.

m)	 mUtkh¡f«	 M)	 gšÿlf«

ï)	 bra‰TW

<)	 ït‰¿š vJîÄšiy

� [Éil:  M) gšÿlf«]
5.	 ciu k‰W« Kida§fS¡»ilnaahd 

ïiz¥ò M»at‰iw¡ bfh©oU¡F« 
mik¥ò vJ?

m)	 Ûciu	 M)	 ÃH‰gl«

ï)	 Ãiyahd ciu	 <)	 xË

� [Éil: m) Ûciu]

6.	 ciuÆ‹ ïilbtË k‰W« ÃW¤j‰F¿fis¥ 
bghW¤jJ vJ?

m)	 ciuÆ‹ thá¥ò¤j‹ik

M)	 bt¡l® gl§fŸ

ï)	 Ãw§fË‹ v©Â¡if

<)	 ït‰¿š vJîÄšiy

� [Éil: m) ciuÆ‹ thá¥ò¤j‹ik]

7.	 v£L ã£LfŸ v‹gJ v¤jid Ãw§fŸ 
bfh©lJ?

m)	 2 Ãw§fŸ	 M)	 16 Ãw§fŸ

ï)	 256 Ãw§fŸ

<)	 ït‰¿š vJîÄšiy�

� [Éil: ï) 256 Ãw§fŸ]

8.	 ïa‰if njh‰w¤â‰F Fiwªjg£r« 
Édho¡F v¤jid r£lf§fŸ ïU¡f 
nt©L«?

m)	 5	 M)	 15	 ï)	 20	 <)	 25

� [Éil: <) 25]

9.	 khwhj ã‹dÂia¡ bfh©l âiuÆš xU 
bghUis ef®¤Jtij cŸsl¡»aJ.

m)	 ghij mirñ£lš

M)	 r£lf« mirñ£lš

ï)	 ïu©L«

<)	 ït‰¿š vJî« ïšiy

� [Éil: m) ghij mirñ£lš]

10.	 gy bghU£fŸ xnu rka¤âš ef®tj‰F 
mDkâ¥gJ

m)	 ghij mirñ£lš

M)	 r£lf« mirñ£lš

ï)	 ïu©L«

<)	 ït‰¿š vJî« ïšiy

� [Éil: M) r£lf« mirñ£lš]

11.	 fÂÅfŸ k‰W« Ä‹dQ fUÉfS¡fhf 
cUth¡f¥g£l jukhd bjhl®ò fUÉ vJ?

m)	 Graphics Interchange Format
M)	 Digital Audio
ï)	 Musical Instrument Digital Indentifier	
<)	 Joint Photographic Experts, Group
� [Éil: ï) Musical Instrument Digital 

Indentifier]

12.	 xË¡fh£á v¤jid tif¥gL«?

m)	 ïu©L	 M)	 _‹W

ï)	 eh‹F	 <)	 IªJ

� [Éil: m) ïu©L]

13.	 RTF ik¡nuhrh¥£ ÃWtd¤jhš vªj M©L 
m¿Kf¥gL¤j¥g£lJ?

m)	 1980	 M)	 1983

ï)	 1985	 <)	 1987

� [Éil: <) 1987]

14.	 fÂ¥bgh¿ gâ¥gf cy»š bghJthdJ vJ?

m)	 RFT	 M)	 Plain Text
ï)	 TIFF	 <)	 JPEG
� [Éil: ï) TIFF]

This is Only for Sample  
For Full BookOrder Online and Available at All Leading Bookstores

orders@surabooks.com Ph:9600175757 / 8124201000

www.su
ra

bo
ok

s.c
om



 g
h
l
«

 1



 RuhÉ‹  fÂÅ ga‹ghLfŸ  12 M« tF¥ò

8

15.	 BMPia x¤jJ vJ?

m)	 RTF	 M)	 DIB
ï)	 TIFF	 <)	 JPEG
� [Éil: M) DIB]

16.	 Fiwªj msî t©z§fis¥ ga‹gL¤J« 
tiufiy¡F Äf¢áwªj nfh¥ò tot« vJ?

m)	 RTF	 M)	 DIB
ï)	 GIF	 <)	 JPEG
� [Éil: ï) GIF] 

17.	 mâf bjËî¤âw‹ ÃH‰gl§fS¡fhd Kjš 
ãugykhd tot« vJ?

m)	 TGA	 M)	 OGG
ï)	 MP3	 <)	 PNG
� [Éil: m) TGA] 

18.	 ïiria nrÄ¡fî« gâÉw¡f« brŒaî« 
Äfî« ãugykhd tot« vJ?

m)	 DVD	 M)	 MP3
ï)	 OGG	 <)	 RA
� [Éil: M) MP3]

19.	 áwªj X£l¤âid miltj‰fhd 
totik¡f¥g£l ïytr âwªj _y bfhŸfy‹ 
tot« vJ?

m)	 DVD	 M)	 MP3
ï)	 OGG	 <)	 RA
� [Éil: ï) OGG] 

20.	 Apple ÃWtd« ga‹gL¤J« jukhd xÈ 
tot« vJ?

m)	 OGG	 M)	 MP3
ï)	 WMA	 <)	 AIFF
� [Éil: <) AIFF]

21.	 MPEG – 21 gšÿlf f£lik¥ò MŒî v¥nghJ 
bjhl§»aJ?

m)	 1987	 M)	 1990
ï)	 2000	 <)	 2005
� [Éil: ï) 2000]

22.	 gšÿlf¤ij cUth¡F« brayhdJ vij 
bjhl¡f¥òŸËahf bfh©L bjhl§F»wJ?

m)	 fU¤JUit	 M)	 tiugl¤ij

ï)	 tuî bryî â£l¤ij

<)	 â£l totik¥ig

� [Éil: m) fU¤JUit]

23.	 ã‹tUtdt‰WŸ bghUsl¡f tšYeuhš 
gšÿlf totik¥ghsU¡F tH§f¥gL« 
jftšfŸ vJ?

m)	 F¿¡nfhŸ	 M)	 brašghLfŸ

ï)	 fU¤JU	 <)	 bghUsl¡f«

� [Éil: <) bghUsl¡f«]

24.	 vªj bk‹bghUis¡ bfh©L ciuahdJ 
ïiz¡f¥gL»wJ?

m)	 OCR	 M)	 OGG
ï)	 WMA	 <)	 MP3
� [Éil: m) OCR]

25.	 â£lÄl¥g£l ga‹gh£o‹ bghUsf¤ij¥ 
g‰¿a mid¤J MuhŒ¢á brašghLfisí« 
brŒtj‰F bghW¥ghs®fŸ ah®?

m)	 jahÇ¥ò nkyhs®

M)	 bghUsl¡f tšYe®

ï)	 °»Ç¥£ vG¤jhs®

<)	 ciu gâu¥ghs®

� [Éil: M) bghUsl¡f tšYe®]

26.	 fU¤JU¡fis K¥gÇkhz NHšfËš 
fh£á¥gL¤Jgt® ah®?

m)	 jahÇ¥ò nkyhs®

M)	 bghUsl¡f tšYe®

ï)	 °»Ç¥£ vG¤jhs®

<)	 ciu gâu¥ghs®

� [Éil: ï) °»Ç¥£ vG¤jhs®] 

27.	 v¥bghGJ« f£lik¥ghfî« rÇahd 
ïy¡fz¤njhL« ïU¡f nt©oaJ vJ?

m)	 ciu	 M)	 xÈ

ï)	 xË	 <)	 mirñ£lš

� [Éil: m) ciu]

28.	 3-D bghUŸfŸ, mirñ£lš k‰W« á‹d§fŸ 
M»at‰iw¡ ifahS« g§»id t»¥gt®

m)	 gšÿlf totik¥ghs®	

M)	 ciu gâ¥ghs®

ï)	 tiy tšYe®

<)	 fÂÅ tiufiy fiyP®

� [Éil: <) fÂÅ tiufiy fiyP®]

29.	 bghU¤jkhd bkhÊÆš F¿Kiw mšyJ 
°»Ç¥£ tÇfis vGJgt® ah®?

m)	 gšÿlf totik¥ghs®

M)	 fÂÅ Ãuy®

ï)	 tiy tšYe®

<)	 ciu gâ¥ghs®

� [Éil: M) fÂÅ Ãuy®]
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30.	 mbkÇ¡fh el¤âa MŒÉ‹go ïiza¤ij 
ga‹gL¤â thbdhÈ nritfis¥ 
bgWgt®fË‹ v©Â¡if

m)	 15 ÄšÈa‹	 M)	 25 ÄšÈa‹

ï)	 30 ÄšÈa‹	 <)	 55 ÄšÈa‹

� [Éil: <) 55 ÄšÈa‹]

31.	 Ãfœ neu Ãfœ¢áfis ïiza¤â‹ _y« 
neuoahd xËgu¥ò brŒtJ

m)	 jhÅa§F nrit tH§»

M)	 tiy xËgu¥ò

ï)	 Ä‹ gâ¥gf«

<)	 ïy¡f gšÿlf üyf§fŸ

� [Éil: M) tiy xËgu¥ò]

nfho£l ïl¤ij Ãu¥òf.

1.	 xU js¤âš ïUªJ k‰bwhU js¤â‰F 
gad®fŸ juit ïiz¤J kh‰w _______ 
mDkâ¡»wJ.

m)	 gšÿlf«	 M)	 mUtkh¡f«

ï)	 g‰gy brayh¡f«

<)	 ït‰¿š vJîÄšiy

� [Éil: m) gšÿlf«]
2.	 gad®fS¡F jftš tH§F« mo¥gilÆš, 

_______ ga‹ghLfŸ K¡»a g§F t»¡»wJ.

m)	 mUtkh¡f«

M)	 g‰gy brayh¡f«

ï)	 gšÿlf«

<)	 ït‰¿š vJîÄšiy

� [Éil: ï) gšÿlf«]
3.	 gšÿlf« _____ ï‹ gy tot§fis x‹whf 

ïiz¡»wJ.

m)	 ciuÆ‹	 M)	 Clf§fË‹

ï)	 xËÆ‹	 <)	 tiufiyÆ‹

� [Éil: M) Clf§fË‹]
4.	 ãw eg®fSl‹ jftš bjhl®ã‰fhd Äfî« 

bghJthd tÊ _______ MF«.

m)	 ciu	 M)	 mirñ£lš

ï)	 xË	 <)	 ÃH‰gl«

� [Éil: m) ciu]

5.	 xU jiy¥ãnyh mšyJ xU tÇÆnyh mšyJ 
xU g¤âÆnyh brhš khwhkš ïUªjhš mJ  
_______ MF«.

m)	 ÃH‰gl«	 M)	 xÈ

ï)	 xË	 <)	 Ãiyahd ciu

� [Éil: <) Ãiyahd ciu]

6.	 ___ flªJ bršy gadU¡F be»œî¤j‹ikí« 
k‰W« nj®ªbjL¥igí« tH§F»wJ.

m)	 ÃH‰gl¤âš	 M)	 ÛîiuÆš

ï)	 xËÆš<)	 Ãiyahd ciuÆš

� [Éil: M) ÛîiuÆš]

7.	 gšÿlf¥  bghUËš,  jftiy¤ bjÇÉ¥gj‰fhf 
_______ ga‹gL»wJ.

m)	 xÈ	 M)	 xË

ï)	 ciu	 <)	 gl«�

� [Éil: ï) ciu]

8.	 _______ v‹gJ gl¥òŸË v‹wiH¡f¥gL« 
á¿a òŸËfË‹ vËa mÂahF«.

m)	 ã£nk¥	 M)	 bt¡l® gl§fŸ

ï)	 tÇfŸ	 <)	 br›tf gl§fŸ

� [Éil: m) ã£nk¥]

9.	 mirñ£lÈš, _______ v‹gJ xU bt¡l® 
glkhF«.

m)	 ciu	 M)	 âiubghUŸ

ï)	 xÈ	 <)	 xË�

� [Éil: M) âiubghUŸ]

10.	 _______ v‹gJ vªjbthU bkhÊÆY« cŸs 
m®¤jKŸs ng¢rhF«.

m)	 xË¡fh£á	 M)	 xÈ

ï)	 mirî¥gl«	 <)	 Ûciu�

� [Éil: M) xÈ]

11.	 _______ v‹gJ xÈ msÉ‹ msåL MF«.

m)	 blágš	 M)	 Û£l®

ï)	 È£l®	 <)	 »nyh»uh«

� [Éil: m) blágš]

12.	 khâÇ xÈ v‹gJ _______ xÈahF«.

m)	 fy¥ò	 M)	 ïy¡f

ï)	 x¥òik

<)	 ït‰¿š vJîÄšiy�

� [Éil: M) ïy¡f]

13.	 gšÿlf ga‹ghLfËš jftiy¤ bjÇÉ¡f 
r¡â thŒªj tÊ c£bghâªj _______ MF«.

m)	 mirñ£lš	 M)	 xÈ

ï)	 gl«	 <)	 xË¡fh£á

� [Éil: <) xË¡fh£á]

14.	 Ä‹dŠriy mD¥òtj‰fhd mrš k‰W« 
ãugykhd tÊ _______ MF«.

m)	 RTF 	 M)	 Plain Text
ï)	 TIFF	 <)	 JPEG�

� [Éil: M) Plain Text]
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15.	 _______ bgU«ghY« mid¤J bk‹bghUŸ 
bjhF¥òfis MjÇ¡»wJ. 

m)	 TIFF 	 M)	 RTF
ï)	 Plain Text	 <)	 JPEG�

� [Éil: m) TIFF] 

16.	 _______ v‹gJ FW¡f¥g£l ÃH‰gl totkhF«.

m)	 DIB 	 M)	 GIF
ï)	 RTF	 <)	 JPEG�

� [Éil: M) GIF] 

17.	 _______ mâfg£r ÃH‰gl FW¡f¤ij 
miltj‰fhf totik¡f¥g£LŸsJ. 

m)	 DIB 	 M)	 GIF
ï)	 RTF	 <)	 JPEG�

� [Éil: <) JPEG] 

18.	 _______ tot« ïiza¤âš xÈÆ‹ 
X£l¤â‰fhf totik¡f¥g£ljhF«.

m)	 RA 	 M)	 DVD
ï)	 MP3	 <)	 OGG�
� [Éil: m) RA] 

19.	 _______ xU É©nlhÌ‰fhd xU 
xË¡fh£á nfh¥ò totkhF«.

m)	 AVI 	 M)	 MPEG
ï)	 OAG	 <)	 WMA�
� [Éil: m) AVI]

20.	 â£l¤âš cŸs F¿¥ã£l T‰WfŸ _______ 
vd¥gL«.

m)	 F¿¡nfhŸ

M)	 neh¡f§fŸ

ï)	 tiuKiw

<)	 ït‰¿š vJî« ïšiy�

� [Éil: M) neh¡f§fŸ]

21.	 neh¡f¤ij brašgL¤Jtj‰F bjhl®¢áahd 
brašfis Ãfœ¤Jtij _______ v‹»nwh«.

m)	 F¿¡nfhŸ

M)	 tiuKiw

ï)	 brašghLfŸ

<)	 ït‰¿š vJî« ïšiy�

� [Éil: ï) brašghLfŸ]

22.	 mid¤J gšÿlf â£l§fËY« _______ 
v‹gJ f£lha« MF«.

m)	 â£l¤ij tH§Fjš

M)	 Mtz¥gL¤Jjš

ï)	 nrhâ¤jš	 <)	 cUth¡Fjš

� [Éil: M) Mtz¥gL¤Jjš]

23.	 xU ïiza tiy¥g¡f¤ij cUth¡» mij 
guhkÇ¥gJ _______ ï‹ bghW¥ghF«.

m)	 ciu gâ¥ghs®	 M)	 tiy tšYe®

ï)	 fÂÅ Ãuy®	 <)	 totik¥ghs®

� [Éil: M) tiy tšYe®]

24.	 b#®kÅÆYŸs GMU MdJ gšÿlf tÊ 
f‰ã¤jš k‰W« M‰wš mik¥ã‰F _______ 
vd bgaÇl¥g£LŸsJ.

m)	 MODOLO	 M)	 e–learning
ï)	 distance learning	 <)	 Virtual learning
� [Éil: m) MODOLO]

25.	 _______ bjhÊšJiwÆš F¿¥ãl¤j¡f 
K‹nd‰w¤â‰F gšÿlf bjhÊš E£g« 
K¡»a fhuzkhF«.

m)	 fšÉ	 M)	 bghGJngh¡F

ï)	 tÂf mik¥ò	 <)	 kU¤Jt nrit

� [Éil: M) bghGJngh¡F]

26.	 _______ v‹gJ gad®fŸ bjhLâiu _y« 
jftšfis bgw mDkâ¡F« xU gšÿlf 
fÂ¥bgh¿ahF«.

m)	 jhÅa§F nrit tH§»

M)	 tiy xËgu¥ò

ï)	 Ä‹ gâ¥gf«	

<)	 ïy¡f gšÿlf üyf§fŸ�

� [Éil: m) jhÅa§F nrit tH§»]

bghU¤Jf.

1.	  1. ã£nk¥ (i) blágš

2. mirñ£lš (ii) ntiy mik¥ã‹ 

vG¤jhs®

3. xÈ (iii) bt¡l® gl«

4. Ûîiu (iv) Matrix 

m)	 1,4,3,2			  M)	 3,4,2,1
ï)	 3,2,1,4			  <)	 4,3,1,2
� [Éil: <) 4,3,1,2]

2.	  1. RTF (i) 13 ã£

2. WMA (ii) Window
3. GIF (iii) ik¡nuh rh¥£

4. Notepad (iv) 1987
m)	 1,4,3,2			  M)	 3,4,2,1
ï)	 3,2,1,4			  <)	 4,3,1,2
� [Éil: <) 4,3,1,2]
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Ñœ¡f©l th¡»a§fis fU¤âš bfhŸf.

1.	 T‰W	 : gšÿlf« vD« brhš 'gy k‰W« 

Clf« vd ïu©L brh‰fis cŸsl¡»aJ. 

	 fhuz« 	 : ïu©L mšyJ mj‰F nk‰g£l 

Clf§fis xnu Clf¤âš xnu jftš 

bjhF¥ãš x‹¿iz¡»wJ. 

m)	 T‰W rÇ Mdhš fhuz« jtW

M)	 T‰W jtW Mdhš fhuz« rÇ

ï)	 �T‰W« fhuzK« rÇna. nkY« fhuz« 

T‰W¡F rÇahd És¡fkhF«

<)	 �T‰W« fhuzK« rÇna. Mdhš 

fhuz« T‰W¡F rÇahd És¡fkšy

� [Éil: ï) T‰W« fhuzK« rÇna. 

� nkY« fhuz« T‰W¡F rÇahd 

� És¡fkhF«]

2.	 T‰W  	 : gšÿlf¤âš gl§fŸ K¡»a 

Twhf brašgL»‹wd. 

	 fhuz« 	 : gl¤ij¡ F¿¡f x¥Õ£lsÉš 

á¿jsî juî njit¥gL«.

m)	 T‰W rÇ Mdhš fhuz« jtW

M)	 T‰W jtW Mdhš fhuz« rÇ

ï)	 �T‰W« fhuzK« rÇna. nkY« fhuz« 

T‰W¡F rÇahd És¡fkhF«

<)	 �T‰W« fhuzK« rÇna. Mdhš fhuz« 

T‰W¡F rÇahd És¡fkšy

[Éil: <) T‰W« fhuzK« rÇna. Mdhš 

� fhuz« T‰W¡F rÇahd És¡fkšy]

3.	 T‰W	 : xÈia "blágš" v‹w msåL 

_y« Ã®zÆ¡f Koí«. 

	 fhuz« 	 : blágš xÈ mG¤j Ãiyia 

És¡F»wJ.

m)	 T‰W rÇ Mdhš fhuz« jtW

M)	 T‰W jtW Mdhš fhuz« rÇ

ï)	 �T‰W« fhuzK« rÇna. nkY« fhuz« 

T‰W¡F rÇahd És¡fkhF«

<)	 �T‰W« fhuzK« rÇna. Mdhš 

fhuz« T‰W¡F rÇahd És¡fkšy

� [Éil: ï) T‰W« fhuzK« rÇna. 

� nkY« fhuz« T‰W¡F rÇahd 

� És¡fkhF«]

Ñœ¡f©lt‰WŸ bghUªjhj x‹iw¤ nj®ªbjL.

1.	 m)	 AVI	 M)	 RA
ï)	 OGG	 <)	 WMA
� [Éil: m) AVI]

2.	 m)   nrhâ¤jš
M)	 â£lÄlš

ï)	 fU¤JU gF¥ghŒî

<)	 jahÇ¥ò nkyhs®

� [Éil: <) jahÇ¥ò nkyhs®]
3.	 m)	 Video	 M)	 Animation

ï)	 Text	 <)	 Audio
� [Éil: ï) Text]

FW Édh¡fŸ. � (2 kâ¥bg©fŸ)

1.	 gšÿlf« tH§F« nritia vGJf.
Éil.	nrÄ¤jš, jftš bjhl®ò, tH§fš k‰W« 

ciu, xË, ÃH‰gl«, tiufiy k‰W« xÈ 
M»at‰¿‹ cŸçL - btËpL ClhLjš 
ngh‹w nritfis tH§F»wJ.

2.	 Ãiyahd ciu F¿¥ò tiuf.
Éil.	xU jiy¥ãnyh mšyJ xU tÇÆnyh mšyJ 

xU g¤âÆnyh, ciu mšyJ brhš khwhkš 
ïUªjhš mJ Ãiyahd ciu MF«.

3.	 Ûciu F¿¥ò tiuf.
Éil.	Ûîiu v‹gJ Kida«, ciu k‰W« 

Kida§fS¡»ilnaahd ïiz¥ò 
M»at‰iw¡ bfh©oU¡F« mik¥ghF«. 
ïJ bjhl® tÇira‰w KiwÆš, ciuia 
mQFtj‰F gad® ã‹g‰w njitahd 
ghijia (path) tiuaW¡F«.

4.	 ïy¡f xÈ F¿¥ò tiuf.
Éil.	khâÇ xÈ v‹gJ ïy¡f xÈahF«. khâÇ 

xÈia vL¤J, x›bthU nth beho¥bghGijí« 
ã£ k‰W« ig£LfËš ïy¡f jftšfshf¢ 
nrÄ¡f¥gL»wJ. 

5.	 tiy xËgu¥ò v‹whš v‹d?
Éil.	Ãfœ neu Ãfœ¢áfis ïiza¤â‹ _y« 

neuoahf xËgu¥ò brŒtJ tiy xËgu¥ò 
vd¥gL«.

6.	 xË¡fh£á fyªJiuahlš v‹whš v‹d?
Éil.	xË¡fh£á fyªJiuahlš v‹gJ bt›ntW 

ïl§fËš cŸs ïu©o‰F« nk‰g£l 
g§fhs®fS¡»ilna fyªJiuahliy el¤â 
mjid xÈ k‰W« xË juîfis fÂÅ 
tiyaik¥ò _y« mD¥ò« xU brayhF«.
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áW Édh¡fŸ.� (3 kâ¥bg©fŸ)

1.	 áW F¿¥ò tiuf.   i) RTF    ii) Plain Text 
Éil.	(i)	 �RTF: Kj‹ik nfh¥ò tot« RTF (Rich 

Text Format) ik¡nuhrh¥£ ÃWtd¤jhš 

1987 M« M©L ãuRÇ¡f¥g£l 

jahÇ¥òfË‹ F¿¥òfŸ k‰W« FW¡F 

gÂ¤js Mtz§fË‹ gÇkh‰w§fnshL 

m¿Kf¥gL¤j¥g£lJ.

(ii)	 Plain Text : Plain Text nfh¥òfis gy 

ciu gâ¥gh‹fËš âw¡fyh«, go¡fyh« 

k‰W« gâ¥ghŒî brŒayh«. Note pad 
(Windows), Gedit mšyJ nanp (UNIX, 
Linux) Text edit (Mac Os) ngh‹wit 

bghJthf ga‹gL»wJ.

2.	 ïy¡f xË¡fh£á tot§fis ÉtÇ.

Éil.	AVI (Audio / Video Interleave) :
(i)	 ïJ xU É©nlhÌ‰fhd xU xË¡fh£á 

nfh¥ò totkhF«. 

(ii)	 ï§F, xÈ k‰W« gl¤â‹ TWfis¡ 

nfh¥ãš kh‰W beLtÇir bjhF¥ãš 

(interleave chunk) nrÄ¡f¥gL»wJ. 

MPEG (Moving Picture Experts Group): 
(i)	 MPEG v‹gJ ïy¡f xË¡fh£á k‰W« 

xÈ FW¡f¤ij ISO (International Standards 
Organization) FGÉduhš cUth¡f¥gL« 

xU juÃiy MF«. 

(ii)	 ïªj FGÉd® k‰W« MP3 M»at‰W¡F 

mo¥gil juÃiyahF«. MPEG-4 v‹gJ 

gšÿlf« k‰W« if¥ngá tiy¡fhd 

juÃiyahF«. 

(iii)	 MPEG xÈ k‰W« xË bghUsl¡f¤ij¤ 

njLtj‰fhd ju ÃiyahF«. 2000- š 

MPEG-21 `gšÿlf f£lik¥ò' g‰¿a 

MŒit¤ bjhl§»aJ. 

(iv)	 RU¡fkhf, MPEG v‹gJ ïy¡f xË¡fh£á 

k‰W« xÈ FW¡f¤â‰fhd juÃiyahF«.

3.	 ïiza¤â‹ gšÿlf¤â‹ ga‹ghLfŸ g‰¿ 
vL¤J¡fh£Ll‹ ÉtÇ.

Éil.	(i)	� ïiza« k‰W« gšÿlf¤â‹ 

xU§»iz¥nghL, K¡»a ga‹ghLfŸ 

cUth¡f¥g£LŸsd.

(ii)	 vL¤J¡fh£lhf, tiugl« k‰W« Clf§fŸ 

Ãiwªj tiy¥gâî (blogs) k‰W« 

ãw, mbkÇ¡fhÉš ïiza« k‰W« 

gšÿlf¤â‹ ga‹fŸ g‰¿a ÉÇthd 

MŒî el¤j¥g£lJ.

(iii)	 mâš 55 ÄšÈa‹ Ef®nth®fŸ x›bthU 

khjK« ïiza¤ij¥ ga‹gL¤â 

thbdhÈ k‰W« xË¡fh£á nritfis¥ 

bgW»wh®fŸ.

(iv)	 ïiza¤âš Äfî« gutyhf ga‹gL¤j¥gL« 

gšÿlf ts« ÃH‰gl« MF«. 

(v)	 Kfüš (facebook) ngh‹w r_f 

tiy¤js§fŸ, gšÿlf Ãiwªj 

bghUsl¡f¤ij ÃfœÃiyÆš gÇkhw 

tÊtif brŒ»wJ.

beLÉdh¡fŸ. � (5 kâ¥bg©fŸ)

1.	 gšÿlf¤â‹ ga‹ghLfis ÉÇthf ÉtÇ.

Éil.	1. 	 fšÉ (Education) :
(i)	 ghu«gÇa f‰ã¤jš Kiw¡F gâyhf 

áwªj kh‰W KiwÆid tH§Ftâš 

gšÿlf« K¡»a g§F M‰W»‹wJ. 

(ii)	 ïJ khzt®fis, mirñ£lš (Animation) 
_y« gšntW fU¤JU¡fis (Concepts) 
g‰¿ MŒî brŒaî«, k‰W« f‰W 

bfhŸsî« mDkâ¡»‹wJ.

(iii)	 gy fšÉahs®fŸ, gšÿlf«, òâa 

tÊfËš tF¥giwÆš áªâ¥gij 

m¿Kf¥gL¤âíŸsJ.

(iv)	 ïªâahÉš, Ä‹ tÊf‰wš (e-learning) 
bjhiyöu tÊ f‰wš (distance learning), 
bkŒÃf® f‰wš (Virtual learning) ngh‹wt‰iw 

f‰ã¤jš k‰W« f‰wY¡fhf gšntW 

tÊfËš gšÿlf« ga‹gL¤j¥gL»‹wJ.

2. 	 bghGJngh¡F (Entertainment) :
(i)	 bghGJngh¡F bjhÊš JiwÆš F¿¥ãl¤j¡f 

K‹nd‰w¤â‰F gšÿlf bjhÊšE£g« 

K¡»a fhuzkhF«. 

(ii)	 ïªj bjhÊš E£gkhdJ thbdhÈ, 

bjhiy¡fh£á, M‹iy‹ Éisah£L, 

njit¥gL« xË¡fh£á ngh‹w mid¤J 

tifahd bghGJngh¡F m«r§fËš 

njit¥gL»‹wJ.

3. 	 tÂf mik¥ò (Business Systems) :
(i)	 gšÿlf tÂf¥ ga‹ghLfŸ tH§Fjš, 

gÆ‰á, ïiza be¿Kiw ngh‹wt‰iw 

cŸsl¡»aJ. 

(ii)	 rªijgL¤Jjš k‰W« És«gu ÃWtd§fŸ 

mirñ£l bjhÊš E£g¤ij Éahghu 

K‹nd‰w¤â‰fhf ga‹gL¤J»‹wd®.
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4. 	 kU¤Jt nritfŸ (Medical Services):
(i)	 gšÿlf¤â‹ ts®¢áÆdhš kU¤Jt 

nritfS« Éa¤jF KiwÆš ts®¢á 

milªJŸsd. 

(ii)	 kU¤Jt khzt®fŸ c©ikahf mWit 

á»¢ir brŒtj‰F K‹cUth¡f¥gL¤Jš 

(Simulation) _y« mWit á»¢ir 

Kiwfis g‰¿ gÆ‰á brŒ»‹wd®.

5. 	 bghJ ïl§fŸ (Public Places) :
(i)	 bjhÊš f©fh£á, üyf§fŸ, ïuÆš 

Ãiya§fŸ, mU§fh£áa«, bgÇa filfŸ, 

Ékhd Ãiya§fŸ,  cztf§fŸ k‰W« 

f©fh£á ngh‹w bghJ ïl§fËš 

gšÿlfkhdJ jhÅa§F nrit tH§» 

(Kiosks) tot¤âš ga‹gL¤j¥gL»‹wJ. 

(ii)	 ïJ tho¡ifahs®fS¡F jftšfis 

tH§» cjî»‹wJ. 

6.	  �gšÿlf¡ fyªJiuahlš (Multimedia 
Conferencing) :

(i)	 gšÿlf¡ fyªJiuahlš mšyJ 

xË¡fh£á fyªJiuahlš v‹gJ xU 

mik¥ghF«. 

(ii)	 ïâš g§nf‰F« gad®fŸ bt›ntW 

ïl§fËÈUªjhY« xnu miwÆš mk®ªJ 

Mnyhá¥gij ngh‹W neU¡F neuhf 

fyªJiuahl Koí«.

2.	 üyf§fËš cŸs gšÿlf bjhÊšE£g ga‹ghLfŸ 
g‰¿ ÉÇthf vGJf.

Éil.	üyf¤â‹ Kj‹ikahd gÂahdJ, gadU¡F 

jftšfis xG§FgL¤â, nrfÇ¤J, ghJfh¤J 

tH§Ftij F¿¡»‹wJ. jftšfis gaDŸs 

tifÆš ifahŸtj‰fhf gy E£g§fŸ k‰W« 

bjhÊš E£g§fŸ ga‹gL¤j¥gL»‹wd.

1.	  �gšÿlf jhÅa§F nrit tH§» 
(Multimedia Kiosks) : 

(i)	 jhÅa§F nrit tH§» (Kiosk) v‹gJ 

gad®fŸ  bjhLâiu (Touch Screen) _y« 

jftšfis bgw mDkâ¡F« xU gšÿlf 

fÂ¥bgh¿ahF«.

(ii)	 ïJ bghJthf  Ékhd Ãiya§fŸ k‰W« 

ãw bghJ ïl§fËš âirfŸ k‰W« áy 

mtáakhd jftšfis gadU¡F tH§f 

cjî»‹wJ. 

(iii)	 üyf§fËš jhÅa§» nrit tH§» 

(Kiosks) ahdJ tH¡fkhf EiHthÆY¡F 

mUnf it¡f¥g£oU¡F«.

2. 	� tiy xËgu¥ò k‰W« xË¡fh£á 
fyªJiuahlš (Webcasting and video 
conferencing) : 

(i)	 Ãfœ   neu Ãfœ¢áfis ïiza¤â‹ 

_y« neuoahf xËgu¥ò brŒtJ tiy 

xËgu¥ò vd¥gL«. 

(ii)	 xË¡fh£á fyªJiuahlš v‹gJ bt›ntW 

ïl§fËš cŸs ïu©o‰F« nk‰g£l 

g§fhs®fS¡»ilna fyªJiuahliy 

el¤â mjid xÈ k‰W« xË juîfis 

fÂÅ tiyaik¥ò _y« mD¥ò« 

xU brayhF«.

3. 	� gadiu xUKf¥gL¤J« â£l« (User 
Orientation Program) : 

	 gšÿlf¤â‹ ClhL« brašghL fhuzkhf 

gŸËTl§fŸ, fšÿÇfŸ k‰W« 

gšfiyfHf§fËš cŸs üyf§fS¡F 

gÆ‰á mË¥gâš gšÿlf« K¡»a g§F 

M‰W»‹wJ.

4. 	� cŸsikî gšÿlf ts§fŸ cUth¡f« 
k‰W« Ä‹ gâ¥gf« (In-house Production 
of Multimedia Resources and E-Publishing) : 

(i)	 bgU«gh‹ikahd üyf§fŸ cŸsikthf 

gšÿlf ts§fis bgÇa mik¥ò¡F 

nrit tH§Ftj‰fhf cUth¡F»‹wd.

(ii)	 CD / DrD k‰W« mjid vGJ« rhjd§fË‹ 

m¿KfkhdJ Mtz§fis nrÄ¤jš 

(or) bgWtâš üyf§fŸ rªâ¡F« áy 

ãu¢ridfS¡F Ô®Éid f©LŸsd.

5. 	� ïy¡f gšÿlf üyf§fŸ (Digital 
Multimedia Libraries) : 

(i)	 ïy¡f tot¤âš cŸs jftyhdJ ïy¡f 

üšfŸ, °nf‹ brŒa¥g£l ÃH‰gl§fŸ, 

tiufiy k‰W« ïy¡f Kiw¡f¥g£l xÈ-

xË gâîfŸ M»at‰iw cŸsl¡»aJ.

(ii)	 bjhl¡f¤âš ïy¡f üyf â£lkhdJ 

(digital library) ciu tot¤âyhd juÉid 

k£Lnk mo¥gilahf¡ bfh©oUªjJ. 


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ghl« mnlh¥ ng{nk¡f®

gFâ - m

I. rÇahd Éilia¤ nj®ªbjL¤J vGJf.

1.	 DTP v‹gj‹ ÉÇth¡f« ________.

m)	 Desktop Publishing
M)	 Desktop Publication
ï)	 Doctor to Patient
 <)	 Desktop Printer
� [Éil: m) Desktop Publishing]

2.	 _________ v‹gJ xU DTP bk‹bghUshF«.

m)	 Lotus 1-2-3		  M)	 PageMaker
ï)	 Maya			   <)	 Flash
� [Éil: M) PageMaker]

3.	 vªj g£oÆš New f£lis ïl«bg‰WŸsJ?

m)	 File menu		  M)	 Edit menu
ï)	 Layout menu	 <)	 Type menu
� [Éil: m) File menu]

4.	 PageMaker r‹dš âiuÆš fU¥ò Ãw 
všiy¡ nfh£o‰F btËÆš ïU¡F« gFâ 
__________ vd miH¡f¥gL«.�[Govt.MQP-2019]
m)	 page			   M)	 pasteboard
ï)	 blackboard		  <)	 dashboard
� [Éil: M) pasteboard]

5.	 PageMaker Mtz¤ij _Ltj‰fhd 
Éir¥gyif FW¡F tÊ ____________.
m)	 Ctrl+A			  M)	 Ctrl+B
ï)	 Ctrl+C			  <)	 Ctrl+W�

� [Éil: <) Ctrl + W]
6.	 __________ fUÉ Mtz¤â‹ xU gFâia¥ 

bgÇjh¡»¥ gh®¡f¥ ga‹gL»wJ.

m)	 Text tool		  M)	 Line tool
ï)	 Zoom tool		  <)	 Hand tool
� [Éil: ï) Zoom tool]

7.	 bg£ofŸ tiutj‰F¥ ga‹gL« fUÉ ____.
m)	 Line			   M)	 Ellipse
ï)	 Rectangle		  <)	 Text
� [Éil: ï) Rectangle]

8.	 Place f£lis ______ g£oÆš ïl«bg‰¿U¡F«.

m)	 File			   M)	 Edit
ï)	 Layout			  <)	 Window
� [Éil: m) File]

9.	 KG Mtz¤ij¤ nj®ªbjL¡f 
Éir¥gyifÆš _______ FW¡F tÊ rhÉ 
nr®khd¤ij mG¤j nt©L«.�
� [HY-2019; Sep-2020]
m)	 Ctrl+A 		  M)	 Ctrl+B
ï)	 Ctrl+C			  <)	 Ctrl+D
� [Éil: m) Ctrl + A]

10.	 vG¤J toñ£lš Ñœ¡f©lt‰¿š vªj 
g©òfis¥ bg‰¿U¡F«?

m)	 Bold			   M)	 Italic
ï)	 Underline		  <)	 All of these

� [Éil: <) All of these]
11.	 ciuia gâ¥ã¡f ga‹gL« fUÉ vJ?

m)	 Text tool		  M)	 Type tool
ï)	 Crop tool		  <)	 Hand tool
� [Éil: m) Text tool]

12.	 PageMaker ïš Mtz¤ij m¢ál¥ ga‹gL« 
Éir¥gyif FW¡F tÊ _________.
m)	 Ctrl+A			  M)	 Ctrl+P
ï)	 Ctrl+C			  <)	 Ctrl+V�

� [Éil: M) Ctrl + P]
13.	 mnlh¥ ng{nk¡f® v‹gJ __________ 

bk‹bghUshF«.�
� [Éil: g¡f totik¥ò]

Édh¡fŸ
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14.	 __________ g£il ng{nk¡f® Mtz¤â‹ 
nkšgFâÆš ïU¡F«.�  
� [Éil: jiy¥ò¥ g£il]

15.	 Mtz¤ij nkY« ÑGkhfî«, ïlJ k‰W« 
tyJ òwkhfî« ef®¤Jtij ___________ 
v‹»nwh«.� [Éil: âiu cUsš]

16.	 _____________ fUÉ t£l« tiutj‰F¥ 
ga‹gL»wJ.� [Éil: vÈ¥° g£il]

17.	 ___________ g£oia¡ »Ë¡ brŒJ Insert 
pages ÉU¥g¤ij¥ bgwyh«.

� [Éil: Layout]
18.	 bghU¤Jf.

m)	 Cut	 – 	 (i)	 Ctrl+Z
M)	 Copy	 –	 (ii)	 Ctrl+V
ï)	 Paste	 –	 (iii)	 Ctrl+X
<)	 Undo	 –	 (iv)	 Ctrl+C�
� [Éil: m - iii, M - iv, ï - ii, < - i]

19.	 Ñœ¡f©lt‰¿š bghUªjhj x‹iw¤ 
nj®ªbjL.

i.	 Adobe PageMaker, QuarkXPress, Adoble 
InDesign, Audacity 

ii.	 File, Edit, Layout, Type, Zip
iii.	 Pointer Tool, Line Tool, Hide Tool, Hand 

Tool
iv.	 Bold, Italic Portrait, Underline
� [Éil: i. Audacity, ii. zip, iii. Hide Tool,  

iv. Portrait]
20.	 Ñœ¡f©lt‰¿š rÇahd T‰iw¤ nj®ªbjL.

i.	 m) �R£oÆ‹ _y« k£Lnk ciuia¤ 
nj®ªbjL¡f Koí«.

	 M) �R£o k‰W« Éir¥gyifÆ‹ _y« 
ciuia¤ nj®ªbjL¡f Koí«.

[Éil: M) R£o k‰W« Éir¥gyifÆ‹ 

_y« ciuia¤ nj®ªbjL¡f Koí«]
ii.	 m) �DTP v‹gj‹ ÉÇth¡f« Desktop 

Publishing.
	 M) �DTP v‹gj‹ ÉÇth¡f« Desktop 

Publication.
[Éil: m) DTP v‹gj‹ ÉÇth¡f« 

Desktop Publishing]
21.	 Ñœ¡f©lt‰¿š rÇahd ïizia¤ nj®ªbjL.

i.	 m) Edit Cut
	 M) Edit New� [Éil: m) Edit cut]
ii.	 m) Undo Copy
	 M) Undo Redo �

� [Éil: M) Undo Redo]

gFâ - M

II. _‹W tÇfËš ÉilaË¡fî«.

1.	 Desktop publishing v‹whš v‹d?� [Sep-2020]
Éil.	bl°¡lh¥ g¥ãËá§ (RU¡fkhf DTP) v‹gJ DTP 

bk‹bghUis¥ ga‹gL¤â Mtz§fS¡fhd 

g¡f§fis totik¥ò (Page Layout) brŒtjhF«.

2.	 DTP bk‹bghUŸfS¡F vL¤J¡fh£LfŸ jUf.

Éil.	mnlh¥ ng{nk¡f® (Adobe PageMaker), mnlh¥ 

ï‹oir‹ (Adope InDesign), Fth®¡ v¡°ãu° 

(Quarkxpress) ngh‹wit.

3.	 ng{nk¡f® bk‹bghUis âw¥gj‰fhd 
tÊKiwfis¡ TW.

Éil.	É©nlh° 7 ïa¡f mik¥ãš, Start > All 
Programs > Adobe > PageMaker 7.0 > Adobe 
Pagemaker 7.0 v‹w tÇirÆš »Ë¡ brŒJ 

mnlh¥ ng{nk¡fiu¤ âw¡fyh«.

4.	 ng{nk¡f® bk‹bghUËš xU òâa Mtz¤ij 
v›thW âw¡fyh«?

Éil.	òâa Mtz¤ij cUth¡f, 

(i)	 g£o¥g£ilÆš File > New v‹gij¡ »Ë¡ 

brŒa nt©L«. mšyJ Éir¥gyif 

_y« Ctrl + N v‹gij mG¤j nt©L«. 

ï¥bghGJ Document setup   ciuahlš 

bg£o njh‹W«.

(ii)	 ïªj ciuahlš bg£oÆš òâa Mtz¤â‰F¤ 

njitahd msîfis cŸçL brŒa 

nt©L«.

(iii)	 ãwF OK bgh¤jhid mG¤j nt©L«.

5.	 x£L¥gyif v‹whš v‹d?� [QY-2019;HY-2019]
Éil.	fU¥ò Ãw všiy¡nfh£o‹ cŸns ïU¥gJ xU 

Mtz¤â‹ g¡f« MF«. fU¥ò Ãw všiy¡ 

nfh£o‰F btËÆš cŸs gFâ x£L¥gyif 

(Pasteboard) vd miH¡f¥gL»wJ. 

6.	 ng{nk¡fÇš cŸs g£o¥g£il g‰¿ F¿¥ò vGJf.

Éil.	g£o¥g£il File, Edit, Layout, Type, Element, 
Utilities, View, Window, Help ngh‹w g£ofis¡ 

bfh©LŸsJ. xU g£oÆš »Ë¡ brŒjhš gy 

f£lisfŸ k‰W« Jiz¥g£ofSl‹ Toa 

ÑœÉÇ g£oaš njh‹W«.
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7.	 vÈ¥° ̂ š k‰W« vÈ¥° ~ãnu« ̂ š ntWgL¤Jf.
Éil.	

fUÉÆ‹ 

bga®

fUÉ¥ 

g£oÆYŸs 

gÂ¡F¿ 

R£L¡F¿ ga‹

vÈ¥° 

^š

t£l« k‰W« 

ÚŸt£l« tiua  

cjî»wJ. 

vÈ¥° 
~ãnu« 
^š

ciu k‰W« 

tiufiyfis 

it¥gj‰fhd 

ÚŸt£l§fis 

tiua 

cjî»wJ.

8.	 ciu gâ¥ã¤jš v‹whš v‹d?� [March-2020]
Éil.	Mtz¤âš cŸs ciuÆš kh‰w§fŸ brŒtJ 

ciu gâ¥ã¤jš (Text Editing) vd¥gL«. ciuia 
nr®¤jš, Ú¡Fjš, ãiH âU¤Jjš, ef®¤Jjš 
k‰W« efbyL¤jš ngh‹w brašfŸ ciu 
gâ¥ã¤jÈš ml§F«.

9.	 ciu¤bjhFâ v‹whš v‹d?
Éil.	ciu¤ bjhFâahdJ eh« j£l¢R brŒj 

ciuianah mšyJ x£oa ciuianah 
mšyJ ntW Mtz¤âÈUªJ bfh©Ltu¥g£l 
ciuianah bfh©oU¡F«.

10.	 bjhl®òŸs ciu¤bjhFâ v‹whš v‹d?�
� [Govt.MQP-2019]

Éil.	xU ciu¤bjhFâÆYŸs ciuahdJ k‰bwhU 
ciu¤ bjhFâ¡FŸ bršYkhW, xU ciu¤ 
bjhFâia k‰bwhU ciu¤ bjhFâíl‹ 
ïiz¡fnth mšyJ bjhl®ògL¤jnth 
Koí«. ï›thW bjhl®ògL¤j¥g£oU¡F« 
ciu¤ bjhFâfS¡F bjhl®òŸs ciu¤ 
bjhFâfŸ  (Threading text blocks) v‹W bga®.

11.	 bjhl®òŸs ciu v‹whš v‹d?
Éil.	ciu¤bjhFâfS¡F ïilna cŸs ciuia 

ïiz¡F« brašKiw¡F bjhl®ògL¤j¥g£l 
ciu (threading text) v‹W bga®.

12.	 ng{nk¡fÇš òâa g¡f§fis v›thW brUfyh«?

Éil.	(i)	� nr®¡f nt©oa g¡f¤â‰F Kjš g¡f¤âš 
»Ë¡ brŒaî«.

(ii)	 g£o¥g£ilÆš Layout > Insert Pages 
v‹gij¡ »Ë¡ brŒaî«.

(iii)	 Insert Page ciuahlš bg£o njh‹W«.

(iv)	 Insert ciu¥bg£oÆš nr®¡f nt©oa 
g¡f§fË‹ v©Â¡ifia cŸËlî«.

(v)	 j‰nghija g¡f¤â‰F ã‹ò g¡f¤ij¢ 
nr®¡f, page(s) ÑÊw§F¥ g£oÆš 'after' 
v‹gij¡ »Ë¡ brŒaî«.

(vi)	 Insert bgh¤jhid mG¤jî«.

(vii)	 ï¥bghGJ òâa g¡f§fŸ nr®¡f¥g£oU¡F«.

gFâ - ï

III. xU g¤âasÉš ÉilaË¡fî«.

1.	 ng{nk¡f® v‹whš v‹d? mj‹ ga‹fis TW.
Éil.	mnlh¥ ng{nk¡f® v‹gJ xU g¡f totik¥ò 

bk‹bghUshF«.

ga‹fŸ :

(i)	 ïJ m¢áLtj‰F V‰w tifÆš 
Mtz§fis totik¡f¥ ga‹gL»wJ.

(ii)	 ïij¥ ga‹gL¤â á¿a tÂf m£il 
Kjš bgÇa ò¤jf« tiu mid¤ijí« 
totik¡fyh«.

(iii)	 g¡f totik¥ò, bk‹ bghUËš cŸs 
fUÉfŸ, Mtz¤âš vËjhf ciu 
k‰W« tiufiy tot§fis nr®¡f 
cjî»‹wd.

(iv)	 cjhuzkhf, ng{nk¡fiu¥ ga‹gL¤â, 
x›bthU g¡f¤âY« f£LiufŸ k‰W« 
gl§fis it¤J xU brŒâ kliy 
cUth¡f Koí«.

2.	 ng{nk¡fÇš cŸs VnjD« _‹W fUÉfisí« 
mj‹ Éir¥gyif FW¡F tÊfisí« TW.
� [HY-2019]

Éil.	

fUÉfŸ (Tools) Éir¥gyif 
FW¡F tÊ 

1. ghÆ‹l® ^š (Pointer Tool) F9
2. buh£nlo§ ^š (Rotating Tool) Shift + F2
3. iy‹ ^š (Line Tool) Shift + F3

3.	 ng{nk¡fÇš  cŸs VnjD« _‹W fUÉfË‹ 
FW«gl§fisí« mj‹ ga‹fisí« TW.

Éil.	

fUÉÆ‹ 

bga®

fUÉ¥ 

bg£oÆYŸs 

gÂ¡F¿ 

R£L¡F¿ ga‹

ghÆ‹l® 

^š

ciu k‰W« 

tiufiy¥ 

gl§fis¤ 

nj®ªbjL¡f, 

ef®¤j, 

msit 

kh‰w 

cjî»wJ.
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bl¡°£ 

^š

ciuia 

cŸËl, 

nj®ªbjL¡f, 

gâ¥ã¡f 

cjî»wJ.

buh£nlo§ 

^š

bghUŸfis 

nj®ªbjL¡f 

k‰W« RH‰w 

cjî»wJ.

4.	 ãÇ¡f¥g£l ciu¤bjhFâia v›thW nr®¥ghŒ?

Éil.	ãÇ¡f¥g£l ïu©L ciu¤bjhFâfis Û©L« 

x‹whf ïiz¥gj‰F :

(i)	 brUF« òŸËia ïu©lhtJ 

ciu¤bjhFâÆ‹ Ñœ¥g¡f if¥ãoÆš »Ë¡ 

brŒJ mj‹ nkšgFâ tiu ïG¡fî«.

(ii)	 ãwF brUF« òŸËia Kjš 

ciu¤bjhFâÆ‹ Ñœ¥g¡f if¥ãoÆš 

»Ë¡ brŒJ Ñœneh¡» njitahd 

msÉ‰F ïG¡fî«. ï¥bghGJ ãÇ¡f¥g£l 

ïu©L ciu¤bjhFâfS« x‹whf 

ïiz¡f¥g£LÉL«.

5.	 ciu cŸs r£l§fis v›thW ïiz¥ghŒ?

Éil.	ciu cŸs r£l§fis ïiz¡f 

(i)	 r£l¤â‰fhd fUÉia¥ ga‹gL¤â 

ïu©lhtJ r£l« tiua nt©L«.

(ii)	 Kjš r£l¤ij »Ë¡ brŒJ nj®ªbjL¡f 

nt©L«.

(iii)	 Ñœ¥g¡f if¥ãoÆYŸs át¥ò 

K¡nfhz¤ij¡ »Ë¡ brŒa nt©L«.

(iv)	 ã‹d® ïu©lhtJ r£l¤ij¡ »Ë¡ brŒa 

nt©L«. ciu ïu©lhtJ r£l¤âš 

ÉÇí«.

6.	 kh°l® g¡f¤â‹ ga‹ v‹d?� [QY-2019]
Éil.	(i)	� kh°l® g¡f¤âš it¡f¥gL« vªjbthU 

bghUS« Mtz¤âš cŸs mid¤J¥ 

g¡f§fËY« njh‹W«.

(ii)	 kh°l® g¡f§fŸ bghJthf nyhnfh¡fŸ, 

g¡f v©fŸ, jiy¥òfŸ k‰W« 

mo¡F¿¥òfis¡ bfh©oU¡»‹wd.

(iii)	 nkY« mitfŸ Column guides, Ruler guides 
k‰W« Margin guides Ií« bfh©LŸsd.

7.	 kh°l® g¡f¤âš g¡f v©fis v›thW nr®¥ghŒ?

Éil.	(i)	� Master Pages gÂ¡F¿Æš »Ë¡ brŒa 

nt©L«.

(ii)	 ï¥bghGJ bl¡°£ ̂ iy¡ »Ë¡ brŒjhš 

brUF« òŸË I-beam Mf khW«.

(iii)	 g¡f v© ïl nt©oa ïlJ kh°l® 

g¡f¤ij¡ »Ë¡ brŒa nt©L«.

(iv)	 Ctrl + Alt + P v‹gij mG¤j nt©L«.

(v)	 ïlJ kh°l® g¡f¤âš g¡f v© 'LM' 
vd¤ njh‹W«.

(vi)	 ïnj ngh‹W g¡f v© ïlnt©oa tyJ 

kh°l® g¡f¤ij¡ »Ë¡ brŒa nt©L«.

(vii)	 Ctrl + Alt + P v‹gij mG¤j nt©L«.

(viii)	tyJ kh°l® g¡f¤âš g¡f v© 'RM' 
vd¤ njh‹W«. k‰w g¡f§fËš rÇahd 

g¡f v©fŸ bjÇí«.

gFâ - <

IV. xU g¡f msÉš ÉilaË¡fî«.

1.	 ng{nk¡f® fUÉ¥bg£oÆYŸs fUÉfis¥ g‰¿ ÉtÇ.� [Govt.MQP-2019; QY-2019; HY-2019; March-2020]

Éil.	

fUÉÆ‹ bga®

fUÉ¥ 

g£oÆYŸs 

gÂ¡F¿ 

R£L¡F¿ ga‹fŸ

ghÆ‹l® ^š
ciu k‰W« tiufiy¥ gl§fis¤ 

nj®ªbjL¡f, ef®¤j, msit kh‰w

bl¡°£ ^š ciuia cŸËl, nj®ªbjL¡f, gâ¥ã¡f

buh£nlo§ ^š bghUŸfis nj®ªbjL¡f k‰W« RH‰w

»uh¥ã§ ^š tiufiyfis xG§fik¡f
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iy‹ ^š ne®nfhL tiua

f‹°buŒ‹L  
iy‹ ^š

»ilk£lkhfî«, br§F¤jhfî« nfhLfŸ 
tiua

bu¡lh§fš ^š rJu« k‰W« br›tf« tiua

bu¡lh§fš ~ãnu« 
^š

ciu k‰w« tiufiyfis it¥gj‰fhd 
br›tf§fis tiua

vÈ¥° ^š t£l« k‰W« ÚŸt£l« tiua 

vÈ¥° ~ãnu« ^š
ciu k‰W« tiufiyfis it¥gj‰fhd 
ÚŸt£l§fis tiua

ghÈfh‹ ^š gynfhz§fŸ tiua

ghÈfh‹ ~ãnu« ^š
ciu k‰w« tiufiyfis it¥gj‰fhd gy 
nfhz§fis tiua

nA©£ ^š g¡f¤ij âiu cUsš brŒa

#]« ^š
g¡f¤â‹ msit bgÇjh¡»í«, á¿jh¡»í« 
gh®¡f

2.	 r£l¤âš ciuia it¥gj‰fhd tÊKiwfis¡ 
TW.

Éil.	ciuia it¡f ciu¤ bjhFâfS¡f gâyhf 
r£l§fisí« ga‹gL¤jyh«. r£l¤âš 
ciuia it¡f 

(i)	 fUÉ¥bg£oÆš cŸs br›tf« mšyJ 
ÚŸt£l« mšyJ gynfhz« ~ãnu« 
^šfËš VnjD« x‹¿‹ ÛJ »Ë¡ 
brŒa nt©L«.

(ii)	 mij¥ ga‹gL¤â xU r£l« tiua nt©L«. 
m¢r£l« nj®î brŒa¥g£LŸsij cWâ 
brŒJ bfhŸs nt©L«.

(iii)	 g£o¥g£ilÆš File g£oia nj®î brŒa 
nt©L«.

(iv)	 ãwF Place v‹gij¡ »Ë¡ brŒa nt©L«. 
Place ciuahlš bg£o njh‹W«.

(v)	 brUf nt©oa ciu cŸs Mtz¤ij 
nj®î brŒa nt©L«.

(vi)	 Open bgh¤jhid¡ »Ë¡ brŒa nt©L«.

(vii)	 ciuia brUf nt©oa r£l¤âš »Ë¡ 
brŒa nt©L«. ciuahdJ r£l¤âš 

brUf¥g£LÉL«.

3.	 ciu¤bjhFâÆYŸs ciuia r£l¤â‰F v›thW 
kh‰WthŒ?� [QY-2019]

Éil.	ciu¤bjhFâÆš ciuia cUth¡»a ã‹ 

mij r£l¤â‰F kh‰w Ñœ¡f©l tÊKiwfis 

ã‹g‰w nt©L«.

(i)	 ng{nk¡fÇš cŸs ~ãnu« ^šfËš 

VnjD« x‹iw¥ ga‹gL¤â r£l« 

x‹iw tiua nt©L«.

(ii)	 r£l¤â‰FŸ brUf nt©oa ciu¤bjhFâia¤ 

nj®ªbjL¡f nt©L«.

(iii)	 Shift Éiria mG¤â¡ bfh©L r£l¤ij¡ 

»Ë¡ brŒa nt©L«. ï¥bghGJ ïu©L 

bghUŸfS« nj®ªbjL¡f¥g£oU¡F«.

(iv)	 g£o¥ g£ilÆš Element > Frame >  Attach 
Content v‹gij¡ »Ë¡ brŒa nt©L«.

(v)	 ï¥bghGJ ciuahdJ r£l¤â‰FŸ 

njh‹W«.

4.	 ghÈfh‹ ^iy¥ ga‹gL¤â xU e£r¤âu« 
tiutj‰fhd tÊKiwfis¡ TW. [Sep-2020]

Éil.	e£r¤âu« tiua

(i)	 fUÉ¥ bg£oÆÈUªJ ghÈfh‹ ^iy 

nj®ªbjL¡f nt©L«. R£L¡F¿ahdJ 

crosshair Mf khW«.

(ii)	 âiuÆš njitahd ïl¤âš »Ë¡ brŒJ 

ïG¡f nt©L«.

(iii)	 R£oia mG¤Jtij É£lîl‹, xU 

gynfhz« tiua¥g£oU¡F«.

(iv)	 g£o¥g£ilÆš Element > Polygon Settings 
v‹gij¤ nj®ªbjL¡fî«.

(v)	 ï¥bghGJ Polygon Settings ciuahlš 

bg£o njh‹W«.

(vi)	 mâYŸs Number of sides ciu¥bg£oÆš 

5 vd cŸËlî«.

(vii)	 Star inset ciu¥bg£oÆš 50% vd cŸËlî«.

(viii)	ãwF OK bgh¤jhid mG¤jî«. ï¥bghGJ 

âiuÆš xU e£r¤âu« bjÇí«.
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muR nj®î Édh ÉilfŸ

1 kâ¥bg©

1.	 bghU¤Jf :� [QY-2019]

(A) Cut 1) Ctrl + V
(B) Copy 2) Ctrl + S
(C) Save 3) Ctrl + X
(D) Paste 4) Ctrl + C

A B C D
(a) 1 2 3 4
(b) 3 4 1 2
(c) 4 1 2 3
(d) 3 4 2 1 [Éil: <) 3 4 2 1]

2.	 ng{nk¡f® fUÉ¥bg£oÆYŸs iy‹ LÈš 
ïU Kiw »Ë¡ brŒjhš _________ ciuahlš  
bg£o njh‹W«� [QY-2019]
m)	 Rounded Corners	 M)	 Custom stroke
ï)	 Polygon settings	 <)	 Go to page

� [Éil: M) Custom stroke]

3.	 ng{nk¡fÇš cŸs xU Mtz¤âid 
òâajhf âw¡f ÉirgyifÆ‹ FW¡FtÊ 
v‹d?� [March-2020]
m)	 Ctrl + Q	 M)	 Ctrl + M
ï)	 Ctrl + N	 <)	 Ctrl + X�
� [Éil: ï) Ctrl + N]

4.	 mnlh¥ ng{nk¡fÇš ghÆ‹l® ̂ š bgWtj‰fhd 
Éir¥gyif FW¡F tÊ :� [Sep-2020]
m)	 F2	 M)	 F5	
ï)	 F7	 <)	 F9�
� [Éil: <) F9]

5.	 ng{nk¡f® Mtz¤âš msînfhiy âiuÆš 
fh©ã¡f _______ I¡ »Ë¡ brŒa nt©L«. 
� [Sep-2020]
m)	 View → Ruler
M)	 Show → Ruler
ï)	 View → Show Rulers	
<)	 VJÄšiy� [Éil: m) View → Ruler]

2 kâ¥bg©fŸ

1.	 ng{nk¡fÇ‹ Mtz¤âš cŸs vG¤ij v›thW 
mÊ¡fyh«?� [March-2020]

Éil.	1.	� brUF« òŸËia mÊ¡f nt©oa 

vG¤â‹ ïlJ òw« it¡f nt©L«.

2.	 Éir¥gyifÆš Delete Éiria mG¤j 

nt©L«.

(mšyJ)

3.	 brUF« òŸËia mÊ¡f nt©oa 

vG¤â‹ tyJ òw« it¡f nt©L«.

4.	 Éir¥gyifÆš backspace Éiria 

mG¤j nt©L«.

3 kâ¥bg©fŸ

1.	 ng{nk¡fÇš xU g¡f¤ij v›thW bgÇjh¡» 
(magnify) fh£lyh« v‹gij És¡Ff.�  

� [Govt.MQP-2019]
Éil.	ng{nk¡fÇš xU g¡f¤ij bgÇjh¡f,

1. 	 #&« ̂ iy nj®ªbjL¡f nt©L«. ï¥bghGJ 

#&« ^š MdJ T£lš F¿íl‹ Toa 

xU ój¡f©zho ngh‹W njh‹W«. 

ïªj¡ T£lš F¿, Mtz¤â‹ gFâia¥ 

bgÇjh¡»¡ fh£L« v‹gij¡ F¿¡»wJ.

2. 	 (ój¡f©zhoÆ‹ ika¤âš fÊ¤jš 

F¿ ïUªjhš mJ Mtz¤â‹ 

gFâia á¿jh¡»¡ fh£L«) #&« ^iy 

bgÇjh¡ FtâÈUªJ á¿jh¡Ftj‰F«, 

á¿jh¡FtâÈUªJ bgÇjh¡Ftj‰F« 

kh‰Wtj‰F Ctrl Éiria mG¤j 

nt©L«. bgÇjh¡» mšyJ á¿jh¡»¥ 

gh®¡fnt©oa ïl¤â‹ ika¤âš 

ój¡f©zhoia it¤J »Ë¡ brŒa 

nt©L«. Mtz« ek¡F¤ njitahd 

msÉ‰F bgÇjhF«tiu mšyJ á¿jhF« 

tiu »Ë¡ brŒJ bfh©nl ïU¡f nt©L«. 

bgÇjh¡FtJ« á¿jh¡FtJ« mj‹ 

všiyia¤ bjh£lîl‹ ój¡f©zhoÆ‹ 

ika¤âš vªj¡ F¿pL« ïU¡fhJ.

2.	 ng{ nk¡f® Mtz¤ij v›thW nrÄ¥ghŒ?�

� [HY-2019]

Éil.	(i)	� g£o¥g£ilÆš File>Save As v‹gij¡ »Ë¡ 

brŒa nt©L«. (mšyJ) Éir¥gyifÆš 

Shift+Ctrl+S v‹w rhÉ nr®khd¤ij mG¤j 

nt©L«. ï¥bghGJ Save Publication 

ciuahlš bg£o âiuÆš njh‹W«.

	   (ii)    �ciu¥bg£oÆš òâa bgaiu j£l¢R 

brŒa nt©L« mšyJ òâa ïl¤ij 

nj®ªbjL¡f nt©L«.

(iii)	� ãwF save bgh¤jhid mG¤â Mtz¤ij 

nrÄ¡f nt©L«.
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3.	 kh°l® g¡f« (Master page) v‹whš v‹d?

� [March-2020]
Éil.	(i) 	� kh°l® g¡f¤âš it¡f¥gL« vªjbthU 

bghUS« Mtz¤âš cŸs mid¤J¥ 

g¡f§fËY« njh‹W«.

(ii)	 mL¤jL¤j g¡f§fËš Ú§fŸ Û©L« 

mnj bghUŸfis cUth¡f nt©oa 

mtáaÄšiy.

(iii)	 mjdhš neu¤â‹ msî Fiw»wJ. 

kh°l® g¡f§fŸ bghJthf nyhnfh¡fŸ 

(logos) g¡f v©fŸ, jiy¥òfŸ k‰W« 

mo¡F¿¥òfis¡ bfh©oU¡»‹wd. 

(iv)	 nkY« mitfŸ Column guides, Ruler guides 
k‰W« Margin Guides Ií« bfh©LŸsd.

4.	 mnlh¥ ng{nk¡fÇš ciu¤bjhFâÆ‹ msit 

v›thW kh‰WthŒ?� [Sep-2020]

Éil.	ciu¤bjhFâÆ‹ msit kh‰w,

(i)	 ghŒ‹l® ^iy¡ »Ë¡ brŒaî«.

(ii)	 ciu¤bjhFâÆ‹ Ñœ¥òw¤âš ïlJ 

mšyJ tyJ g¡f if¥ãoia¡ 

»Ë¡ brŒJ ïG¡fî«. R£oia 

mG¤Jtij É£lîl‹, ciuahdJ 

ciu¤bjhFâÆ‹ òâa msÉ‰F 

bghUªJkhW kh¿ÆU¡F«.

(iii)	 É©nlhn[o‹ Ñœ¥òw¤âš cŸs 

át¥ò K¡nfhz«, ciu¤bjhFâÆ‹ 

btËÆš bjÇtijÉl mâfkhd ciu 

cŸns kiwªâU¡»wJ v‹gij¡ 

fh£L»wJ. if¥ãoia ÑnH ïG¥gj‹ 

_y« kiwªâU¡F« ciuia¥ 

gh®¡fyh«.

	

TLjš Édh¡fŸ

rÇahd Éilia¤ nj®ªbjL¤J vGJf. (1 kâ¥bg©)

1.	 bk‹bghUŸ rªijÆš »il¡F« òfœbg‰w 

DTP-bk‹bghUŸfŸ vJ? �

m)	 mnlh¥ ng{nk¡f®

M)	 mnlh¥ ï‹oir‹

ï)	 Fth®¡ v¡°ãu°	

<)	 ïit mid¤J«

� [Éil: <) ïit mid¤J«]

2.	 vij¥ ga‹gL¤â á¿a tÂf m£il 

Kjš bgÇa ò¤jf« tiu mid¤ijí« 

totik¡fyh«?

m)	 mnlh¥ ng{nk¡f®

M)	 mnlh¥ ï‹oir‹

ï)	 Fth®¡ v¡°ãu°

<)	 ïit mid¤J«

� [Éil: m) mnlh¥ ng{nk¡f®]

3.	 fU¥òÃw všiy¡ nfh£o‰F btËÆš cŸs 

gFâ v›thW miH¡f¥gL»wJ?

m)	 x£L¥gyif

M)	 Mtz¤â‹ g¡f«

ï)	 ïu©L«

<)	 ït‰¿š vJîÄšiy

� [Éil: m) x£L¥gyif]

4.	 r‹dš âiuÆ‹ nkš gFâÆš cŸsJ vJ?

m)	 jiy¥ò¥g£il

M)	 g£o¥g£il

ï)	 fUÉ¥g£il

<)	 âiu cUsš g£il

� [Éil: m) jiy¥ò¥g£il]

5.	 fUÉ¥g£ilÆš njh‹W« á¿a ciu âiu¡F 

v‹d bga®?

m)	 Untitled
M)	 Help Tool
ï)	 Tool Tip
<)	 ït‰¿š vJîÄšiy

� [Éil: ï) Tool Tip]

6.	 ng{nk¡f® Mtz¤âš v¤jid msî 

nfhšfŸ cŸsd?
m)	 2	 M)	 3	 ï)	 4	 <)	 5

� [Éil: m) 2]

7.	 ciu¤bjhFâia cUth¡f vªj ^iy 
ga‹gL¤j nt©L«?

m)	 iy‹ ^š	 M)	 #]« ^š

ï)	 vÈ¥° ^š	 <)	 bl¡°£ ^š

� [Éil: <) bl¡°£ ^š]

8.	 Ñœ¡f©lt‰¿š vJ ciu¥gâ¥ã¤jÈš 
ml§F«?

m)	 ciuia nr®¤jš

M)	 ciuia Ú¡Fjš

ï)	 ciuia efbyL¤jš

<)	 ïit mid¤J«

� [Éil: <) ïit mid¤J«]
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9.	 I-beam R£L¡F¿ _y« xU th®¤ijia 

nj®ªbjL¡f v¤jid Kiw »Ë¡ brŒa 

nt©L«?

m)	 ïu©L		  M)	 _‹W

ï)	 eh‹F		  <)	 IªJ

� [Éil: m) ïu©L]

10.	 eh« ïWâahf ga‹gL¤âa f£lisia âU«g¥ 

bgw vªj f£lis ga‹gL»wJ.

m)	 Undo	 M)	 Copy
ï)	 Backspace		  <)	 Delete
� [Éil: m) Undo]

11.	 nrÄ¡f¥g£l Mtz¤ij ntW bgaÇš mšyJ 

ntW ïl¤âš nrÄ¡f vªj f£lisia 

ga‹gL¤jyh«?

m)	 Save	 M)	 Save As
ï)	 Copy
<)	 ït‰¿š vJîÄšiy

� [Éil: M) Save As]

12.	 ng{nk¡f® Mtz¤âš âiu cUsš g£ilfŸ 

v¤jid cŸsd?

m)	 2	 M)	 3	 ï)	 4	 <)	 5

� [Éil: m) 2]

13.	 Mtz¤â‹ vªjbthU gFâiaí« 

bgÇjh¡fî«, á¿jh¡fî« fh£l cjîtJ vJ?

m)	 iy‹ ^š	 M)	 #]« ^š

ï)	 vÈ¥° ^š	 <)	 bl¡°£ ^š

� [Éil: M) #]« ^š]

14.	 ciuia xU F¿¥ã£l toÉš fh©ã¥gij 

v›thW miH¡»nwh«?

m)	 âiu cUsš	 M)	 ciu gâ¥ã¤jš

ï)	 vG¤J toñ£lš

<)	 ït‰¿š vJîÄšiy

� [Éil: ï) vG¤J toñ£lš]

15.	 xU g¡f¤âÈUªJ k‰bwhU g¡f¤â‰F 

bršy Éir¥gyifÆš vªj Éirfis¥ 

ga‹gL¤jyh«?

m)	 Page Up
M)	 Page Down
ï)	 `m' k‰W« `M'

<)	 ït‰¿š vJîÄšiy

� [Éil: ï) ‘m’ k‰W« ‘M’]

16.	 vªj ÉU¥g¤âš g¡f v©fis¡ bfhL¤J 
xU g¡f¤ijnah mšyJ bjhl®¢áahd gy 

g¡f§fisnah m¢ályh«?

m)	 All
M)	 Print
ï)	 Ranges
<)	 ït‰¿š vJîÄšiy

� [Éil: ï) Ranges] 

17.	 bjhl®¢áahd g¡f§fis m¢ál vjid 

ga‹gL¤j nt©L«?

m)	 .	 M)	 ,	 ï)	 –	 <)	 :
� [Éil: ï) –] 

18.	 vG¤Jtif (Font) v‹gJ?

m)	 vG¤JfŸ	 M)	 v©fŸ

ï)	 F¿pLfŸ	 <)	 ïit mid¤J«

� [Éil: <) ïit mid¤J«]

nfho£l ïl¤ij Ãu¥òf.

1.	 bl°¡lh¥ g¥ãËá§ v‹gJ _______ bk‹ 

bghUis¥ ga‹gL¤â Mtz§fS¡fhd 

g¡f§fis totik¥ò brŒtjhF«.

m)	 DTP
M)	 HTML
ï)	 ADP
<)	 ït‰¿š vJîÄšiy

� [Éil: m) DTP]

2.	 fU¥ò Ãw všiy¡ nfh£o‹ cŸns ïU¥gJ xU 

_______ MF«.

m)	 x£L¥gyif

M)	 Mtz¤â‹ g¡f«

ï)	 ïu©L«

<)	 ït‰¿š vJîÄšiy�

� [Éil: M) Mtz¤â‹ g¡f«]

3.	 fUÉ¥ bg£o âiuÆš njh‹whÉ£lhš, 
g£o¥g£ilÆš _______ v‹gij¡ »Ë¡ brŒJ 
bgwyh«.

m)	 Window > Hide Tools 
M)	 Window > Tool menu
ï)	 Window > Show tools
<)	 ït‰¿š vJîÄšiy

� [Éil: ï) Window > Show tools]
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4.	 Mtz¤ij ef®¤Jtij _______ v‹»nwh«.

m)	 âiu ef®¤Jjš

M)	 âiu cUsš

ï)	 `m' k‰W« `M'

<)	 ït‰¿š vJîÄšiy�

� [Éil: M) âiu cUsš]

5.	 Mtz¤âš cŸs ciuÆš kh‰w§fŸ brŒtJ 
_______ vd¥gL«.

m)	 ciuia Ú¡Fjš

M)	 ciuia nr®¤jš

ï)	 ciu gâ¥ã¤jš	

<)	 cUis cUsš

� [Éil: ï) ciu gâ¥ã¤jš]

6.	 I-beam R£L¡F¿ _y« xU g¤âia 
nj®ªbjL¡f _______ Kiw »Ë¡ brŒa 
nt©L«.

m)	 ïu©L	 M)	 _‹W

ï)	 eh‹F	 <)	 IªJ�

� [Éil: M) _‹W]

7.	 _______ f£lisahdJ, nj®ªbjL¡f¥g£l 
ciuÆ‹ efiy cUth¡F»wJ.

m)	 Paste	 M)	 Delete
ï)	 Copy	 <)	 Undo�
� [Éil: ï) Copy]

8.	 _______ _y« ciu¤ bjhFâÆš »Ë¡ 
brŒjhš, ciu¤bjhFâÆ‹ všiyfŸ 
bjÇí«.

m)	 bl¡°£ ^š

M)	 ghŒ‹l® ^š

ï)	 vÈ¥° ^š	

<)	 ït‰¿š vJîÄšiy�

� [Éil: M) ghŒ‹l® ^š]

9.	 _______ v‹gJ brŒâ¤jhËš tU« 
f£Liuia x¤jjhF«.

m)	 ng{nk¡f® °nlhÇ

M)	 ï‹oir‹

ï)	 HTML
<)	 ïit vJîÄšiy�

� [Éil: m) ng{nk¡f® °nlhÇ]

10.	 _______ F¿ahdJ ïu©L Éirfis 
nr®¤J mG¤j nt©L« v‹gij¡ F¿¡»wJ. 

m)	 T£lš	 M)	 fÊ¤jš

ï)	 bgU¡fš	 <)	 tF¤jš

� [Éil: m) T£lš]

11.	 vG¤J¡fË‹ tif, Ãw« ngh‹w bghJthd 
g©òfis kh‰w¡Toa braY¡F _______ 
v‹W bga®.

m)	 toñ£lš	 M)	 âiu cUsš

ï)	 ciu gâ¥ã¤jš

<)	 ït‰¿š vJîÄšiy�

� [Éil: m) toñ£lš]

12.	 Vuhskhd toñ£lšfis¢ brŒí« nghJ 
_______ Äfî« gaDŸsjhf ïU¡»wJ.

m)	 Rounded Corners
M)	 f©£nuhš ngy£

ï)	 ‘m' k‰W« ‘M'

<)	 ït‰¿š vJîÄšiy

� [Éil: M) f©£nuhš ngy£]

13.	 bu¡lh§fš ^iy¥ ga‹gL¤â _______ tiua 
nt©L«.

m)	 rJu« 	 M)	 br›tf«

ï)	 e£r¤âu tot«

<)	 ït‰¿š vJîÄšiy�

� [Éil: M) br›tf«]

14.	 x‰iw¥ g¡f kh°l® gÂ¡F¿ia¡ F¿¡f 
_______ k£Lnk ga‹gL¤j¥gL»wJ.

m)	 L 	 M)	 R	 ï)	 W	 <)	 X
� [Éil: M) R] 

15.	 x‹¿‰F nk‰g£l g¡f v©fŸ _______ _y« 
ãÇ¡f¥gl nt©L«.

m)	 . 	 M)	 ,	 ï)	 –	 <)	 :�
� [Éil: M) ,] 

16.	 Éir¥gyifÆš _______ I mG¤âdhš 
Colors Palette âiuÆš njh‹W«. 

m)	 Ctrl + I 	 M)	 Ctrl + X
ï)	 Ctrl + L	 <)	 Ctrl + J�
� [Éil: <) Ctrl + J] 

17.	 kh°l® g¡f¤âš _______ cŸsd.

m)	 Ruler Guides 	 M)	 Column Guides
ï)	 Margin Guides	 <)	 ïit mid¤J«

� [Éil: <) ïit mid¤J«] 

18.	 Print ÑÊw§F¥ bg£oÆš _______ v‹gij¤ 
nj®ªbjL¤J x‰iw¥gil g¡f v© cila 
g¡f§fis m¢ál Koí«.

m)	 Odd Pages 	 M)	 Even Pages
ï)	 ‘m' k‰W« ‘M'

<)	 ït‰¿š vJîÄšiy�

� [Éil: m) Odd Pages]
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19.	 Print ÑÊw§F¥ bg£oÆš _______ v‹gij¤ 

nj®ªbjL¤J ïu£il¥gil g¡f v© cila 

g¡f§fis m¢ál Koí«.

m)	 Odd Pages 
M)	 Even Pages
ï)	 ‘m' k‰W« ‘M'

<)	 ït‰¿š vJîÄšiy�

� [Éil: M) Even Pages] 

bghU¤Jf.

1.	  1. DTP (i) F9
2. ghÆ‹l® ^š (ii) Shift + F3
3. iy‹ ^š (iii) Shift + F5
4. vÈ¥° ^š (iv) Page Layout

m)	 3,4,2,1			  M)	 4,1,2,3
ï)	 1,2,3,4			  <)	 2,3,4,1
� [Éil: M) 4,1,2,3]

2.	  1. efbyL¡f (i) Ctrl + '
2. x£l (ii) br›tf«

3. f©£nuhš ngy£ (iii) Ctrl + V
4. bu¡lh§fš ^š (iv) Ctrl + C

m)	 1,2,3,4			  M)	 4,3,1,2
ï)	 2,3,4,1			  <)	 3,4,2,1
� [Éil: M) 4,3,1,2]

Ñœ¡f©l th¡»a§fis fU¤âš bfhŸf.

1.	 T‰W 	 : �nrÄ¡f¥g£l Mtz¤ij ntW 

bgaÇš mšyJ ntW ïl¤âš 

nrÄ¡f Save As f£lisia¥ 

ga‹gL¤jyh«. 

	 fhuz«	 : �Save As f£lis Mtz¤â‹ òâa 

efiy cUth¡F»wJ.

m)	 T‰W rÇ Mdhš fhuz« jtW

M)	 T‰W jtW Mdhš fhuz« rÇ

ï)	� T‰W« fhuzK« rÇna. nkY« fhuz« 

T‰W¡F rÇahd És¡fkhF«

<)	� T‰W« fhuzK« rÇna. Mdhš fhuz« 

T‰W¡F rÇahd És¡fkšy

[Éil: <) T‰W« fhuzK« rÇna. Mdhš 

� fhuz« T‰W¡F rÇahd És¡fkšy]

2.	 T‰W  	 : �Mtz¤âš cŸs ciuÆš 

kh‰w§fŸ brŒtJ ciu 

gâ¥ã¤jš vd¥gL«. 

	 fhuz« 	 : �ciuia nr®¤jš, Ú¡Fjš, ãiH 

âU¤Jjš, ef®¤Jjš k‰W« 

efbyL¤jš ngh‹w brašfŸ 

ciu gâ¥ã¤jÈš ml§F«.

m)	 T‰W rÇ Mdhš fhuz« jtW

M)	 T‰W jtW Mdhš fhuz« rÇ

ï)	� T‰W« fhuzK« rÇna. nkY« fhuz« 

T‰W¡F rÇahd És¡fkhF«

<)	� T‰W« fhuzK« rÇna. Mdhš 

fhuz« T‰W¡F rÇahd És¡fkšy

� [Éil: ï) T‰W« fhuzK« rÇna. 

nkY« fhuz« T‰W¡F rÇahd 

� És¡fkhF«]

Ñœ¡f©lt‰WŸ bghUªjhj x‹iw¤ nj®ªbjL.

1.	 m)   Page Maker	        M)	      Indesign
ï)	 QuarkXPress	 <)	 Ubuntu
� [Éil: <) Ubuntu]

2.	 m)   Type	        M)	      Print
ï)	 Import	 <)	 Paste
� [Éil: M) Print]

3.	 m)   bl¡°£ ^š	        M)	     nA‹£ ^š

ï)	 iy‹ ^š	 <)	 r‹dš âiu

� [Éil: <) r‹dš âiu]

FW Édh¡fŸ.� (2 kâ¥bg©fŸ)

1.	 Tool Tip v‹whš v‹d?

Éil.	fUÉ¥g£ilÆš cŸs xU bgh¤jh‹ ÛJ 

R£oia it¡F« nghJ, mij g‰¿a á¿a 

ciu âiuÆš njh‹W«, mj‰F 'Tool Tip' 
v‹W bga®.

2.	 âiu cUsš v‹whš v‹d?

Éil.	Mtz¤ij nkY« ÑGkhfî«, ïlJ 

k‰W« tyJ òwkhfî« ef®¤Jtij âiu 

cUsš brŒjš v‹»nwh«.

3.	 ng{nk¡f® Mtz¤âš msînfhšfŸ g‰¿a 

F¿¥ò tiuf.

Éil.	ng{nk¡f® Mtz¤â‹ nkš k‰W« ïlJ 

Xu¤âš ïu©L msînfhšfŸ cŸsd.
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(i)	 msînfhiy âiuÆš fh©ã¡f, 

g£o¥g£ilÆš View > Show Rulers 
v‹gij¡ »Ë¡ brŒa nt©L«.

(ii)	 msînfhiy kiw¡f, g£o¥g£ilÆš 

View > Hide Rulers v‹gij¡ »Ë¡ 

brŒa nt©L«.

4.	 ciu¤bjhFâia v¤jid tÊfËš 

cUth¡fyh«?

Éil.	ciu¤bjhFâia ïu©L tÊfËš 

cUth¡fyh« :

(i)	 Mtz¥ g¡f¤âš mšyJ 

x£L¥gyifÆš bl¡°£ ^iy¡ »Ë¡ 

brŒJ ïG¤J, mâš j£l¢R brŒtj‹ 

_y« ciu¤bjhFâia cUth¡fyh«.

(ii)	 xU fhÈahd Mtz¥g¡f¤ânyh 

mšyJ g¤âÆnyh (Column) 
ciuna‰w¥g£l (Loaded Text) 
gÂ¡F¿ia¡ »Ë¡ brŒtj‹ _y« 

ciu¤bjhFâia cUth¡fyh«.

5.	 ng{nk¡f® °nlhÇ v‹whš v‹d?

Éil.	ng{nk¡f® °nlhÇ (story) v‹gJ 

brŒâ¤jhËš tU« f£Liuia x¤jjhF«. 

brŒâ¤jhË‹ Kjš g¡f¤âš gšntWg£l 

brŒâfS¡fhd f£LiufŸ ïU¡F«. 

mj‹ bjhl®¢á ntW g¡f§fËš ïU¡F«. 

ïnj nghy ng{nk¡f® Mtz¤âš gy 

°nlhÇfŸ xnu g¡f¤âš ïU¡fyh«. mj‹ 

bjhl®¢á ntW g¡f§fËš ïU¡fyh«.

6.	 bjhl®òŸs ciu¤bjhFâfŸ v‹whš v‹d?

Éil.	xU ciu¤bjhFâÆYŸs ciuahdJ 

k‰bwhU ciu¤bjhFâ¡FŸ bršYkhW, 

xU ciu¤bjhFâia k‰bwhU 

ciu¤bjhFâíl‹ ïiz¡fnth 

mšyJ bjhl®ògL¤jnth Koí«. 

ï›thW bjhl®ògL¤j¥g£oU¡F« 

ciu¤bjhFâfS¡F bjhl®òŸs 

ciu¤bjhFâfŸ (Threading text blocks) 
v‹W bga®.

7.	 bghUŸ v‹whš v‹d?

Éil.	ng{nk¡f® Mtz¤âš j£l¢R 

brŒa¥gL« ciufŸ, tiua¥gL« mšyJ 

jUÉ¡f¥gL« tiufiyfŸ bghUŸ vd 

miH¡f¥gL«. bghUŸ Mtz¥ g¡f¤ânyh 

mšyJ x£L¥gyifÆnyh ïU¡fyh«.

8.	 r£l¤âš cŸs ciuia v›thW ãÇ¡fyh«?

Éil.	r£l¤âÈUªJ ciuia ãÇ¡f

(i)	 ghÆ‹l® ^š _y« r£l¤ij¡ »Ë¡ 

brŒa nt©L«.

(ii)	 g£o¥ g£ilÆš Element > Frame >   
Delete content v‹gij¡ »Ë¡ brŒa 

nt©L«. ï¥bghGJ r£l¤âš ciu 

ïU¡fhJ.

9.	 #&« ^š _ykhf bgÇjh¡Fjš k‰W« 

á¿jh¡FjY¡fhd tÊKiwfis vGJ.

Éil.	#]« ^š (Zoom Tool) _ykhf Mtz¤â‹ 

vªjbthU gFâiaí« bgÇjh¡»í« 

(magnify), á¿jh¡»í« (reduce) fh£l Koí«. 

#]« ^iy ïUKiw »Ë¡ brŒJ Mtz¥ 

g¡f¤â‹ c©ikahd msití«, Alt 
bgh¤jhDl‹ nr®¤J ïUKiw¡ »Ë¡ 

brŒJ Mtz¥ g¡f« r‹dš âiuíl‹ 

bghUªJ« msití« bgw Koí«.

10.	 Mtz¤ij toñ£lš v‹whš v‹d?

Éil.	vG¤J¡fË‹ tif, Ãw«, ghÂ ngh‹w 

bghJthd g©òfis kh‰w¡ Toa 

braY¡F toñ£lš v‹W bga®. xU 

F¿¥ã£l ghÂÆYŸs vG¤J¡fŸ, 

v©fŸ k‰W« F¿pLfŸ ngh‹wt‰¿‹ 

bjhF¥ã‰F vG¤J tif (font) v‹W 

bga®. xU vG¤J tif k‰w vG¤J 

tiffËÈUªJ ntWg£oU¡F«.

11.	 vG¤J toñ£lš v‹whš v‹d?

Éil.	ciuia xU F¿¥ã£l toÉš fh©ã¥gij 

vG¤J toñ£lš v‹»nwh«. vG¤J 

toñ£lš v‹gJ ciuÆ‹ g©òfshd 

jok‹, rhŒî, mo¡nfhL, vG¤J tif, 

msî, Ãw« M»at‰iw cŸsl¡»ajhF«.

12.	 ciuÆ‹ Ãw¤ij v›thW kh‰wyh«? 

Éil.	(i)	� t©zÄl nt©oa ciuia¤ nj®î 

brŒa nt©L«.

(ii)	 g£o¥g£ilÆš Window>Show Colors 
v‹gij¡ »Ë¡ brŒa nt©L«. 

ï¥bghGJ Colors palette njh‹W«. 

mâš njitahd t©z¤ij¡ 

»Ë¡ brŒa nt©L«. vG¤J¡fŸ 

eh« nj®ªbjL¤j t©z¤â‰F kh¿ 

ïU¡F«.
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áW Édh¡fŸ.� (3 kâ¥bg©fŸ)

1.	 jiy¥ò¥g£il g‰¿ áW F¿¥ò tiuf.

Éil.	(i)	� ïJ r‹dš âiuÆ‹ nkš gFâÆš 

cŸsJ. ïj‹ ïlJ Xu¤âš 

bk‹bghUË‹ bga® k‰W« 

Mtz¤â‹ bga® ïl« bg‰¿U¡F«. 

(ii)	 tyJ Xu¤âš á¿jh¡F¥ bgh¤jh‹, 

bgÇjh¡F¥ bgh¤jh‹, _L bgh¤jh‹ 

ngh‹w f£L¥gh£L bgh¤jh‹fŸ 

ïl«bg‰¿U¡F«.

(iii)	 jiy¥ò¥ g£ilÆ‹ ïlJ Xu¤âš 

Adobe PageMaker 7.0 v‹D« 

bk‹bghUË‹ bgaiuí«, mij¤ 

bjhl®ªJ Untitled-1 v‹D« 

Mtz¤â‹ bfhlhÃiy¥ bgaiuí« 

fhzKo»wJ. 

(iv)	 gad® cÇa bgaiu¡ bfhL¤J 

Mtz¤ij nrÄ¥gj‹ _y« 

Untitled-1 v‹D« bgaiu kh‰¿¡ 

bfhŸs Koí«.

(v)	 á¿jh¡F¥ bgh¤jhid mG¤Jtj‹ 

_y« r‹dš âiu á¿a bgh¤jhdhf 

kh¿ gÂ¥g£il¡F tªJÉL«.

(vi)	 bgÇjh¡F¥ bgh¤jh‹, Mtz« âiu 

KGtJ« Ãu«ò« tifÆš bgÇjh¡f¥ 

ga‹gL»wJ.

(vii)	_L bgh¤jh‹ Mtz¤ij 

_Ltj‰F¥ ga‹gL»wJ.

2.	 fUÉ¥bg£oÆ‹ gl« tiuªJ mj‹ 
ghf§fis¡ F¿¡fî«.

Éil.	

Pointer Tool

Rotating Tool

Line Tool

Rectangle Tool

Ellipse Tool

Polygon Tool

Hand Tool

Text Tool

Cropping Tool

Constrained Line Tool

Rectangle Frame Tool

Ellipse Frame Tool

Polygon Frame Tool

Zoom Tool

3.	 ciu¤bjhFâia ïu©lhf ãÇ¤jY¡fhd 
tÊKiwfis vGJf.

Éil.	ciu¤bjhFâia ïu©lhf¥ ãÇ¤jš.

(i)	 �brUF« òŸËia Ñœ¥g¡f« cŸs 

if¥ãoÆš »Ë¡ brŒJ nkšneh¡» 

ïG¡fî«. R£oia mG¤Jtij 

É£lîl‹ Ñœ¥g¡f if¥ão át¥ò Ãw 

K¡nfhz¤Jl‹ njh‹W«.

(ii)	 kWgoí« mâš »Ë¡ brŒJ mJ 

ciuna‰w¥g£l (Loaded text) 
gÂ¡F¿ahf khW«.

(iii)	 ï¥bghGJ njitahd ïl¤âš »Ë¡ 

brŒjhš, mªj ïl¤âš k‰bwhU 

ciu¤bjhFâ njh‹W«.

4.	 ãw bk‹bghUŸfËš jahÇ¡f¥g£l nfh¥òfis 
ng{nk¡fÇš v›thW brUf Koí«? És¡Ff.

Éil.	MS–Word ngh‹w ãw bk‹bghUŸfËš 

ïU¡F« ciufis ng{nk¡f® Mtz¤âš 

brUf Koí«.

(i)	 g£o¥g£ilÆš File > Place v‹gij¡ 

»Ë¡ brŒa nt©L«. Place ciuahlš 

bg£o njh‹W«.

(ii)	 brUf nt©oa ciu cŸs 

Mtz¤ij¤ nj®ªbjL¡f nt©L«.

(iii)	 Place ciuahlš bg£oÆš cŸs 

Open bgh¤jhid¡ »Ë¡ brŒa 

nt©L«. ï¥bghGJ R£L¡F¿ahdJ 

ciuna‰w¥g£l (loaded text ) 
gÂ¡F¿ahf kh¿ ïU¡F«.

(iv)	 ïªj ciuia ïLtj‰F xU 

ciu¤bjhFâia cUth¡f nt©L«. 

(mšyJ) mªj Mtz¤â‹ xU 

fhÈ¥g¡f¤âš »Ë¡ brŒjhš 

m¥g¡f¤âš m›îiu ïl«bgW«. eh« 

brUf nt©oa ciu xU g¡f¤ij 

Él mâfkhf ïUªjhš, mij gy 

g¡f§fËš it¡f ng{nk¡f® 

mDkâ¡»wJ. ïij jhdikthfnth 

mšyJ gad® f£L¥gh£onyh 

mik¡fyh«.

5.	 òâa kh°l® g¡f¤ij cUth¡Ftj‰fhd 

tÊKiwfis vGJf.

Éil.	(i)	� Master Pages Palette ïš New Master 
Page gÂ¡F¿ia¡ »Ë¡ brŒa 

nt©L«. ï¥bghGJ New Master Page 
ciuahlš bg£o njh‹W«.
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(ii)	 mâš Name v‹D« ciu¥bg£oÆš 

kh°l® g¡f¤â‹ bgaiu cŸËl 

nt©L«.

(iii)	 Margins k‰W« Column Guides 
gFâfËš njitahd kh‰w§fis 

brŒa nt©L«.

(iv)	 ãwF OK bgh¤jhid mG¤jî«. òâa 

kh°l® g¡f«, Master Pages Palette ïš 

njh‹W«.

beLÉdh¡fŸ. � (5 kâ¥bg©fŸ)

1.	 Mtz¤âš ciuia cŸËLjš g‰¿ 

És¡Ff.

Éil.	(i)	� ng{nk¡f® Mtz¤âš ciu¤ bjhFâÆ‹ 

(Text block) cŸns ciuia cŸËl 

nt©L«. 

(ii)	 ciu¤bjhFâia cUth¡f bl¡°£ 

^iy (Text Tool) ga‹gL¤j nt©L«. 

bl¡°£ ̂ iy ga‹gL¤â ciu¤bjhFâia 

cUth¡»aã‹ mâš ciuia neuoahf 

j£l¢R brŒayh«. 

(iii)	 ciuia j£l¢R brŒí« nghJ É£LÉ£L¤ 

njh‹W« beL«g£il x‹W tyJ òwkhf 

ef®ªJ bfh©nl bršY«. mj‰F brUF« 

òŸË v‹W bga®.

(iv)	 ciuia j£l¢R brŒí« bghGJ ciuahdJ 

ciu¤bjhFâÆ‹ Xu¤ij¤ bjh£lîl‹, 

jhdhfnt koªJ mL¤j tÇ¡F¢ bršY«. 

(v)	 ciu¤bjhFâÆ‹ x›bthU tÇ KoÉY« 

EiHî Éiria (Enter Key) mG¤j 

nt©oaâšiy.

(vi)	 xU fhÈ tÇ nt©Lbk‹whnyh mšyJ 

xU g¤âÆ‹ KoÉnyhjh‹ EiHî 

Éiria mG¤j nt©L«.

2.	 R£o mšyJ Éir¥gyif _y« ciuia 

v›thW nj®ªbjL¡fyh« v‹gij g‰¿ 

ÉÇthf vGJf.

Éil.	R£o mšyJ Éir¥gyif _y« ciuia 

nj®ªbjL¡fyh«.

R£o _y« ciuia¤ nj®ªbjLj¤jš: 

R£oÆ‹ _y« ciuia¤ nj®ªbjL¡f 

Ñœ¡f©l tÊKiwfis¥ ã‹g‰wî«. 

(i)	 brUF« òŸËia nj®ªbjL¡f 

ciu¤bjhFâÆ‹ bjhl¡f¤âš 

it¡fnt©L«.

(ii)	 R£oÆ‹ ïlJ bgh¤jhid mG¤â¥ 

ão¤jthW ciuÆ‹ ÛJ ef®¤j 

nt©L«.

(iii)	 njitahd ciu nj®ªbjL¡f¥g£l 

cl‹ R£oia mG¤Jtij É£LÉl 

nt©L«.

(iv)	 ï¥bghGJ ciu ca®¤â¡ 

fh£l¥g£oU¡F«.

	 Éir¥gyif _y« ciuia 

nj®ªbjL¤jš : Éir¥gyif _y« 

ciuia¤ nj®ªbjL¡f Ñœ¡f©l 

tÊKiwfis¥ ã‹g‰wî«.

(i)	 brUF« òŸËia nj®ªbjL¡f 

nt©oa ciuÆ‹ bjhl¡f¤âš 

it¡f nt©L«.

(ii)	 Shift Éiria mG¤âathW ef®î¥ 

bgh¤jh‹fis¥ ga‹gL¤â ciuia¤ 

nj®ªbjL¡f nt©L«.

(iii)	 ciu nj®ªbjL¡f¥g£lîl‹ Shift 
Éiria mG¤Jtij É£LÉl 

nt©L«.

3.	 ng{nk¡f® Mtz¤âš ciuia ef®¤Jjš 

k‰W« efbyL¤jš g‰¿ ÉÇthf vGJf.

Éil.	ciuia ef®¤Jjš : nj®ªbjL¡f¥g£l 

ciuia bt£o, njitahd ïl¤âš x£l 

Koí«.

ciuia bt£o x£Ltj‰F :

(i)	 ef®¤j nt©oa ciuia nj®ªbjL¡f 

nt©L«. 

(ii)	 g£o¥g£ilÆš Edit > Cut v‹gij 

»Ë¡ brŒa nt©L« (mšyJ) 

Éir¥gyifÆš Ctrl + X v‹gij 

mG¤j nt©L«. (mšyJ) R£blÈÆ‹ 

tyJ bgh¤jhid¡ »Ë¡ brŒJ tU« 

g£oaÈš Cut v‹gij¤ nj®ªbjL¡f 

nt©L«.

(iii)	 ciuia x£l nt©oa ïl¤â‰F 

brUF« òŸËia ef®¤j nt©L«.
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(iv)	 g£o¥ g£ilÆš Edit > Paste v‹gij¡ 

»Ë¡ brŒa nt©L«. (mšyJ) 

Éir¥gyifÆš Ctrl + V v‹gij 

mG¤j nt©L«. (mšyJ) R£blÈÆ‹ 

tyJ bgh¤jhid¡ »Ë¡ brŒJ tU« 

g£oaÈš Paste v‹gij¤ nj®ªbjL¡f 

nt©L«.

Éir¥gyif FW¡F tÊfŸ

Ctrl + X → bt£l

Ctrl + V → x£l

ciuia efbyL¤jš : nj®ªbjL¡f¥g£l 

ciuia efbyL¤J, njitahd ïl¤âš 

x£l Koí«.

ciuia efbyL¤J x£Ljš :

(i)	 efbyL¡f nt©oa ciuia nj®ªbjL¡f 

nt©L«.

(ii)	 g£o¥ g£ilÆš Edit > Copy v‹gij¡ »Ë¡ 

brŒa nt©L« (mšyJ) Éir¥gyifÆš 

Ctrl + C v‹gij mG¤j nt©L«. (mšyJ) 

R£blÈÆ‹ tyJ bgh¤jhid¡ »Ë¡ 

brŒJ tU« g£oaÈš Copy v‹gij¤ 

nj®ªbjL¡f nt©L«.

(iii)	 ciuia x£l nt©oa ïl¤â‰F brUF« 

òŸËia ef®¤j nt©L«.

(iv)	 g£o¥ g£ilÆš Edit > Paste v‹gij¡ »Ë¡ 

brŒa nt©L«. (mšyJ) Éir¥gyifÆš 

Ctrl + V v‹gij mG¤j nt©L«. (mšyJ) 

R£blÈÆ‹ tyJ bgh¤jhid¡ »Ë¡ 

brŒJ tU« g£oaÈš Paste v‹gij¤ 

nj®ªbjL¡f nt©L«.

Éir¥gyif FW¡F tÊfŸ

Ctrl + C efbyL¡f

Ctrl + V x£l

4.	 F¿¥ò tiuf. 1.	 gad® f£L¥gh£L ciu¥ghŒî 

2. jhdikî ciu¥ghŒî

Éil.	1. �gad® f£L¥gh£L ciu¥ghŒî 

(Manual text flow) :
(i)	 ciuna‰w¥g£l (Loaded text) 

gÂ¡F¿ia ciuia it¡f 

nt©oa ïl¤âš »Ë¡ brŒJ 

njitahd msÉ‰F ïG¤JÉl 

nt©L«.

(ii)	 ï¥bghGJ ciu eh« tiuaW¤j 

ciu¤bjhFâ¡FŸ tªâU¡F«. ïªj 

ciu¤bjhFâ¡FŸ ciu KGtJ« 

it¡f KoaÉšiy vÅš, Ñœ¥g¡f 

É©nlhn[oš át¥ò Ãw K¡nfhz« 

njh‹W«. ïâš »Ë¡ brŒjhš kWgoí« 

ciuna‰w¥g£l (Loaded text) gÂ¡F¿ 

njh‹W«.

(iii)	 ï¥bghGJ òâa ciu¤bjhFâia cUth¡» 

mâš »Ë¡ brŒa nt©L«. 

(iv)	 ïªj brašKiwia át¥ò Ãw K¡nfhz« 

kiwí« tiu mšyJ brUf nt©oa 

ciu cŸstiu âU«g¤ âU«g brŒa 

nt©L«.

(v)	 ïnj ngh‹W xU g¡f¤âš ciuia brUf 

nt©LbkÅš g¡f¤â‹ nk‰gFâÆš 

ciuna‰w¥g£l (Loaded text) gÂ¡F¿ia 

it¤J »Ë¡ brŒa nt©L«. ciuahdJ 

m¥g¡f« KGtJ« Ãu«ò«. 

(vi)	 xU g¡f¤ij Él mâfkhd ciu ïUªjhš, 

Ñœ¥gFâÆš cŸs É©nlhn[oš át¥ò 

Ãw K¡nfhz« njh‹W«. 

(vii)	ïij¡ »Ë¡ brŒjhš ciuna‰w¥g£l 

(Loaded text) gÂ¡F¿ kWgoí« njh‹W«. 

(viii)	ï¥bghGJ g£o¥ g£ilÆš Layout > 
Insert Pages v‹gij¡ »Ë¡ brŒJ òâa 

g¡f¤ij cUth¡», g¡f¤â‹ nkš 

gFâÆš ciuna‰w¥g£l (Loaded text) 
gÂ¡F¿ia¡ »Ë¡ brŒa nt©L«. 

(ix)	 ïij brUf nt©oa ciu cŸstiu 

âU«g¤ âU«g brŒa nt©L«.

	 jhdikî ciu¥ghŒî (Automatic text 
flow):
(i)	 ciuia V‰Wtj‰F (importing) K‹ò, 

g£o¥ g£ilÆš Layout > Autoflow 
v‹gij¡ »Ë¡ brŒa nt©L«. 

ã‹d® ciuia V‰w nt©L«. 

(ii)	 ï¥bghGJ ciuna‰w¥g£l (Loaded 
text) gÂ¡F¿ r‰W ntWg£L squiggly 
arrow  thf¤ njh‹W«.

(iii)	 ï¥bghGJ ciuna‰w¥g£l (Loaded 
text) gÂ¡F¿ia g¡f¤â‹ nkš 

gFâÆš »Ë¡ brŒjhš, ciuahdJ 

jhdikthf njitahd msÉ‰F 

mL¤jL¤j¥ g¡f§fËš Ãu¥¥gL«.
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5.	 bjhl®òŸs ciu¤bjhFâia bjhl®g‰w 
ciu¤bjhFâah¡Fjiy ÉtÇ.

Éil.	bjhl®òŸs ciu¤bjhFâia bjhl®g‰w 

ciu¤bjhFâah¡Fjš :

brŒKiw 1 :

(i)	 jÅ ciu¤bjhFâahf kh‰w nt©oa 

ciu¤bjhFâia ghÆ‹l® ^š _y« 

nj®ªbjL¡f nt©L«.

(ii)	 g£o¥g£ilÆš Edit > Cut v‹gij¡ »Ë¡ 

brŒjhš ciu¤bjhFâ kiwªJÉL«. 

ã‹d® Edit > Paste v‹gij¡ »Ë¡ brŒa 

nt©L«.

(iii)	 ï¥bghGJ kWgoí« mªj ciu¤bjhFâ 

mnj ïl¤âš njh‹W«. Mdhš mJ 

jÅ ciu¤bjhFâahf kh‰w¥g£oU¡F«.

brŒKiw 2 :

(i)	 bjhl®g‰w ciu¤bjhFâahf kh‰w 

nt©oa ciu¤bjhFâia ghÆ‹l® 

^š _y« nj®î brŒa nt©L«.

(ii)	 bl¡°£ ^iy¡ »Ë¡ brŒJ mªj 

bjhFâÆYŸs ciu KGtijí« 

nj®ªbjL¡f nt©L«. ãwF g£o¥ 

g£ilÆš Edit > Cut v‹gij¡ »Ë¡ 

brŒjhš ciu¤bjhFâ kiwªJÉL«.

(iii)	 ï¥bghGJ brUF« òŸËia V‰fdnt 

cŸs bjhl®òŸs ciu¤bjhFâÆš 

»Ë¡ brŒJ Edit > Paste v‹gij¡ »Ë¡ 

brŒa nt©L«. ï¥bghGJ ciu mªj 

bjhFâÆš nr®¡f¥g£oU¡F«.

6.	 Éir¥gyifÆš cŸs ef®î¥ bgh¤jh‹fis 

vGJf.

Éil.	

Éir¥gyif - ef®î¥ bgh¤jh‹fŸ

ef®¤Jjš mG¤j nt©oa rhÉfŸ

xU vG¤J ïlJòwkhf Left Arrow
xU vG¤J tyJòwkhf Right Arrow
xU th®¤ij ïlJòwkhf Ctrl+Left Arrow
xU th®¤ij tyJòwkhf Ctrl+Right Arrow
xU tÇ nkny Up Arrow
xU tÇ ÑnH Down Arrow
tÇÆ‹ ïWâ¡F End
tÇÆ‹ bjhl¡f¤â‰F Home
xU g¤â nkny Ctrl+Up Arrow
xU g¤â ÑnH Ctrl+Down Arrow

7.	 Mtz¤ij m¢álš g‰¿ ÉÇthf vGJf.

Éil.	Mtz¤ij m¢álš :

(i)	 g£o¥g£ilÆš File>print v‹gij¡ 

»Ë¡ brŒaî«. (mšyJ) Ctrl+P 
v‹D« Éir¥gyif FW¡F tÊia¥ 

ga‹gL¤jî«. Print Document 
ciuahlš bg£o njh‹W«.

(ii)	 mâš Ñœ¡f©l kh‰w§fis brŒaî«.

	 	 �Printer ÑÊw§F¥ g£o¥bg£oÆš 

m¢R¥bgh¿ia nj®ªbjL¡fî«.

	 	 �m¢ál nt©oa g¡f§fis¡ 

F¿¥ãl Pages gFâÆš 

Ñœ¡f©lt‰¿š VnjD« x‹iw¤ 

nj®ªbjL¡fî«.

	 All: ïªj ÉU¥g« Mtz¤âš cŸs 

mid¤J¥ g¡f§fisí« m¢áL«.

	 Ranges: ïªj ÉU¥g¤âš g¡f v©fis¡ 

bfhL¤J xU g¡f¤ijnah mšyJ 

bjhl®¢áahd gy g¡f§fisnah 

m¢ályh«.

	 x‹¿‰F nk‰g£l g¡f v©fŸ fh‰òŸË 

(,) _y« ãÇ¡f¥gl nt©L«. (v.fh 5, 7, 

9)

	 bjhl®¢áahd g¡f§fis m¢ál 

hyphen(-) ga‹gL¤j nt©L«.  

(v.fh 10-17 v‹W bfhL¤jhš g¡f v© 

10âÈUªJ 17 tiu cŸs g¡f§fis 

m¢áL«.)

	 xU F¿¥ã£l g¡f¤âÈUªJ 

Mtz¤â‹ ïWâ tiu m¢ál, m¢ál 

nt©oa bjhl¡f g¡f v©iz¡ 

bfhL¤J hyphen(-) bfhL¡f nt©L«. 

(v.fh.5-)

	 jÅ¤jÅ g¡f v©fis fh‰òŸË 

(,) _y« ãÇ¤J«, bjhl®¢áahd 

g¡f§fis hyphen (-) _yK« bfhL¤J 

xnu neu¤âš m¢ál Koí«. (v.fh 5, 

9,15-26)

	 Print: Print ÑÊw§F¥ g£o¥bg£oÆš 

Odd pages v‹gij¤ nj®ªbjL¤J 

x‰iw¥gil g¡f v© cila 

g¡f§fis k£L« m¢ál Koí«. 

mnj ngh‹W Even pages v‹gij¤ 

nj®ªbjL¤J ïu£il¥gil g¡f v© 

cila g¡f§fis k£L« m¢ál 

Koí«.
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	 	� Copies ciu¥bg£oÆš njitahd 

efšfË‹ v©Â¡ifia 

cŸËl nt©L«.

	 	� Collate v‹D« nj®î¥ bg£oia 

nj®î brŒayh« mšyJ nj®î 

brŒahkY« ïU¡fyh«.

	 IªJ g¡f§fŸ bfh©l xU Mtz¤ij 

eh‹F efšfŸ m¢álnt©LbkÅš, 

ï¥bghGJ collate v‹D« nj®î¥ bg£o 

nj®î brŒahkš ïUªjhš, Kjš 

g¡f« eh‹F efšfŸ m¢á£l ãwF, 

ïu©lhtJ g¡f« eh‹F efšfŸ 

m¢áL«. ïnj ngh‹W IªjhtJ g¡f« 

tiu m¢áL«. Mdhš collate v‹D« 

nj®î¥ bg£o nj®î brŒâUªjhš 

KjÈš x‹¿ÈUªJ IªJ g¡f§fŸ 

tiu bjhl®¢áahf m¢áL«. mj‹ 

ãwF kWgoí« x‹¿ÈUªJ IªJ 

g¡f§fŸ tiu bjhl®¢áahf m¢áL«. 

ïnj ngh‹W eh‹F efšfS« 

m¢ál¥gL«.

(iii)	 ïWâahf Print bgh¤jhid mG¤jî«.

8.	 vG¤J toñ£lš brŒtj‰fhd tÊKiwfis 

vGJf.

Éil.	vG¤J toñ£lš brŒtj‰fhd 

tÊKiwfŸ:

(i)	 toñ£lš brŒa nt©oa ciuia 

nj®ªbjL¡f nt©L«.

(ii)	 g£o¥g£ilÆš Type > Character 
v‹gij¡ »Ë¡ brŒa nt©L«. 

(mšyJ) Ctrl+T v‹D« Éir¥gyif 

FW¡F tÊia¥ ga‹gL¤j nt©L«. 

ï¥bghGJ Character Specifications 
ciuahlš bg£o âiuÆš njh‹W«.

(iii)	 ciuahlš bg£oÆš njitahd 

kh‰w§fis¢ brŒa nt©L«. 

	 	� Font ÑÊw§F g£o¥ bg£oÆ‹ 

m«ò¡F¿ia¡ »Ë¡ brŒJ, 

njitahd vG¤J tifia 

nj®ªbjL¡f nt©L«.

	 	� Font Size ÑÊw§F g£o¥ bg£oÆ‹ 

m«ò¡F¿ia¡ »Ë¡ brŒJ, 

njitahd vG¤â‹ msit¤ 

nj®ªbjL¡f nt©L«.

	 	� Font color ÑÊw§F g£o¥ bg£oÆ‹ 

m«ò¡F¿ia¡ »Ë¡ brŒJ, 

vG¤â‰F¤ njitahd Ãw¤ij 

nj®ªbjL¡f nt©L«.

	 	� Bold, Italic, Underline nj®î¥ 

bg£ofËš »Ë¡ brŒJ ciuia 

jokdhfî«, rhŒthfî«, mo¡ 

nfho£L« fh£lyh«.

(iv)	 ãwF OK bgh¤jhid¡ »Ë¡ brŒa 

nt©L«.


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3
ghl« juîjs nkyh©ik mik¥ò

 - m¿Kf«

Édh¡fŸ
gFâ - m

I. rÇahd Éilia¤ nj®ªbjL¤J vGJf.

1.	 juî¤js¤âÈUªJ jftiy bgWtj‰F vªj 
bkhÊ ga‹gL»wJ?

m)	 cwî Ãiy (Relational)
M)	 f£lik¥ò (Structural)
ï)	 Édtš (Query)
<)	 bjhF¥ã (Compiler)
� [Éil: ï) Édtš (Query)]

2.	 ___________ És¡f¥gl« juîjs¤ij 
jU¡f f£lik¥ò tiuglkhf jU»wJ.�
� [Govt.MQP-2019]
m)	 (E–R (Entity – Relationship)
M)	 cU¥bghUŸ

ï)	 f£lik¥ò F¿¥ò	 <)	 juîjs«

� [Éil: m) (E–R (Entity – Relationship)]
3.	 Kj‹ik âwînfhiy cUth¡f njitahd 

g©ò¡TWfis¥ bg‰¿U¡fhj cU¥bghUŸ.

m)	 Ãiyahd cU¥bghUŸ bjhFâ (Strong 
Entity Set)

M)	 Ãiya‰w cU¥bghUŸ bjhFâ (Weak 
Entity Set)

ï)	 milahs¤ bjhFâ (Identity Set)
<)	 cÇikahs® bjhFâ (Owner Set)
� [Éil: M) Ãiya‰w cU¥bghUŸ 

bjhFâ (Weak Entity Set]
4.	 __________ f£lis juîjs¤ij Ú¡f 

ga‹gL»wJ.

m)	 Delete database database_name
M)	 Delete database_name
ï)	 Drop database database_name
<)	 Drop database_name
� [Éil: <) Drop database_name]

5.	 MySQL, DBMS -‹ vªj tifia rh®ªjJ?

m)	 bghUŸneh¡F (Object oriented)
M)	 goÃiy (Hierarchical)
ï)	 cwîÃiy (Relational)
<)	 tiyaik¥ò (Network)�

� [Éil: ï) cwîÃiy (Relational)]
6.	 MySQL ïytrkhf »il¡F« xU âwªj 

_y« MF«.
m)	 rÇ			   M)	 jtW

� [Éil: m) rÇ]
7.	 Tuble v‹gJ cwîÃiy juîjs¤âš ______ 

ia F¿¡»wJ.

m)	 m£ltiz		  M)	 tÇir

ï)	 beLtÇir		  <)	 bghUŸ

� [Éil: M) tÇir]
8.	 MySQL - Yl‹ bjhl®ig V‰gL¤j¥ ga‹gLtJ.

m)	 SQL			   M)	 Network calls
ï)	 Java	 		  <)	 API's
� [Éil: m) SQL]

9.	 vJ juî brayhf¤â‰F cÇa MySQL?

m)	 MySQL Client
M)	 MySQL Server
ï)	 SQL
<)	 Server Daemon program
� [Éil: M) MySQL Server]

10.	 MySQL juî js¤âš xU juîjs¤â‹ KG 
totik¥ò f£lik¥ig ãuâgÈ¤jš ________ 
vd miH¡f¥gL»wJ.

m)	 â£l« (Schema)
M)	 gh®it (View)
ï)	 Ãfœî (Instance)
<)	 m£ltiz (table)�

� [Éil: m) â£l« (Schema)]
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